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Signet 4630 Free Chlorine Analyzer System
Signet 4632 Chlorine Dioxide Analyzer System

CAUTION!

1. Follow instructions carefully to avoid personal injury.
2. Do not exceed the maximum pressure or temperature specifi cations.
3. Mounting the Chlorine System in an outdoor box, in areas with elevated temperatures,

may cause damage to the system if the enclosure's internal temperature exceeds the
temperature specifi cation of the Chlorine Analyzer.

4. Do not alter product construction.
5. For use with clean fresh water only.
6. Disconnect AC power before opening wiring enclosure.
7. This panel system uses AC voltages. Wiring should be done by qualifi ed personnel only.

Signet

Chlorine Analyzer

The Signet 4630 and 4632 Systems are EPA 334.0 Compliant.

English

Operating Instructions

The Signet Chlorine Analyzer Systems are integrated, all-in-one Chlorine Panel Systems 
designed to measure Free Chlorine or Chlorine Dioxide in drinking water and clean, 
fresh water treatment applications.
This manual includes the 4630 Free Chlorine and 4632 Chlorine Dioxide Analyzer Systems.
Features:
• EPA 334.0 Compliant: The 4630 Free Chlorine and 4632 Chlorine Dioxide Systems can

be used for reporting chlorine residuals in accordance with EPA Method 334.0.
• Complete Chlorine Analyzer System allows quick setup and easy installation. Connect

to a water source and plug it in.
• Unique integrated clear fl ow cell combines sensors, fl ow regulator, fi lter and variable

area fl ow indicator in one compact unit.
• Built-in variable area fl ow indicator facilitates fl ow rate confi rmation at a glance.
• Integrated fl ow regulator with removable fi lter accepts inlet pressures of 1 to 8 bar

(15 to 120 psi) while maintaining constant fl ow and minimal pressure to the sensors.
• Water fl ows vertically into sensor tip, eliminating bubble entrapment. Raised exit in fl ow

cell sensor chamber ensures sensors stay submerged even when system and fl ow is
turned off.

• Flow cell accommodates two sensors; one chlorine and an optional pH sensor.
• Automatic pH and temperature compensation or manual pH value input capability for

accurate free chlorine readings.
• Easy viewing of the transmitter via the bright backlit LCD display.
• Moisture-proof NEMA 4X wiring enclosure.

Additional information can be found in the individual product manuals, 
refer to www.gfsignet.com. 
Click on Product Manuals under the Signet Quick Links section.

  Description

  Safety
• English
• Deutsch
• Français
• Español
• Italiano

CALL TOLL FREE 877-742-2878 FOR SALES AND SUPPORT 
RETURN TO BurtProcess.com

https://www.gfps.com/country_US/en_US/products/sensors/chlorine/4630.html
https://burtprocess.com/
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Warning / Caution / Danger
Indicates a potential hazard. Failure to follow all warnings 
may lead to equipment damage, injury, or death

Electrostatic Discharge (ESD) / Electrocution Danger
Alerts user to risk of potential damage to product by ESD, 
and/or risk of potential of injury or death via electrocution.

Personal Protective Equipment (PPE)
Always utilize the most appropriate PPE during 
installation and service of Signet products.

Pressurized System Warning
Sensor may be under pressure, take caution to vent 
system prior to installation or removal. Failure to do so 
may result in equipment damage and/or serious injury.

Hand Tighten Only
Overtightening may permanently damage product 
threads and lead to failure of the retaining nut.

Do Not Use Tools
Use of tool(s) may damage product beyond repair and 
potentially void product warranty.

Note / Technical Notes
Highlights additional information or detailed procedure.

DO NOT
FREEZE

Do Not Freeze
Products are temperature sensitive and may contain 
freezable liquids. Freezing damage to pH, ORP, and 
Chlorine electrodes voids product warranty.

  Warranty Information   Table of Contents

  Safety Information

  Product Registration
Thank you for purchasing the Signet line of Georg Fischer 
measurement products.
If you would like to register your product(s), you can now 
register online in one of the following ways:

•  Visit our website www.gfsignet.com and
click on Product Registration Form

•  If this is a pdf manual (digital copy), click here
•  Scan the QR Code on the left

Refer to your local Georg Fischer Sales offi ce for the most 
current warranty statement.

All warranty and non-warranty repairs being returned must 
include a fully completed Service Form and goods must be 
returned to your local GF Sales offi ce or distributor. 
Product returned without a Service Form may not be 
warranty replaced or repaired.

Signet products with limited shelf-life (e.g. pH, ORP, chlorine 
electrodes, calibration solutions; e.g. pH buffers, turbidity 
standards or other solutions) are warranted out of box but not 
warranted against any damage, due to process or application 
failures (e.g. high temperature, chemical poisoning, dry-out) 
or mishandling (e.g. broken glass, damaged membrane, 
freezing and/or extreme temperatures).

https://www.gfps.com/country_US/en_US/service_and_support/registration.html
https://www.gfps.com/country_US/en_US/markets/automation.html
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Safety Data Sheets (SDS) are available online at www.
gfsignet.com.

  Dimensions   System Specifi cations

General
Compatible Signet Sensors
3-2630-1 Free Chlorine Sensor  0.02 to 2 ppm
3-2630-2 Free Chlorine Sensor  0.02 to 5 ppm
3-2630-3 Free Chlorine Sensor  0.05 to 20 ppm
3-2632-1 Chlorine Dioxide Electrode  0.02 to 2 ppm
3-2724-00 Flat pH Electrode
Free Chlorine .....................5.5 to 8.5 pH
Chlorine Dioxide ................4.0 to 11 pH

Materials
Panel .................................Black acrylic
Flow Cell ...........................Acrylic
Wiring Enclosure ...............Polycarbonate
Wetted Materials
Flow cell, spacer rings .......Acrylic
Flow regulator housing.......Polycarbonate
Strainer, e-clip, regulator
spring, float .......................Stainless steel
Valves, vent .......................Polypropylene
Flow Cell O-rings,
diaphragm .........................EPR (EPDM), FKM
Chlorine electrode .............PVC, PTFE, FKM, Nylon, Silicone
pH electrode ......................PPS, Glass, UHMW, PE, FKM
Sealing tape
(valves, plug, vent) ............PTFE
Plug ...................................Polyethylene

Performance
System Inlet
Pressure Rating .................1 to 8 bar (15 to 120 psi)
Pressure Regulator ............  < 0.69 bar (10 psi) variation over 

all ranges of flow and pressure
Flow tolerance ...................±15% or rated specification above
Flow rate limits ..................8 to 12 gph (US)

(30.24 to 45.36 LPH)

Electrical
AC Input (standard) ...........100 to 240 VAC nominal

50 to 60 Hz, 0.17 A at 100 VAC
DC Input (optional) ............12 to 24 VDC ±10% regulated, 

10 W, 250 mA max
Environmental Requirements
Storage Temperature .........0 °C to 65 °C (32 °F to 149 °F)
Operating Temperature ......0 °C to 45 °C (32 °F to 113 °F)
Relative Humidity ...............0 to 95%
Maximum Altitude ..............2000 m (6562 ft)
Shipping Weight ................10 kg (22 lbs)
Enclosure ..........................NEMA 4X (with output wire 

glands sealed)
Standards and Approvals
CE, UL, CUL, WEEE
RoHS Compliant
Manufactured under ISO 9001 for Quality, 
ISO 14001 for Environmental Management and 
OHSAS 18001 for occupational health and safety.
 China RoHS (Go to www.gfsignet.com for details)
 Declaration of Conformity according to FCC Part 15 
 This device complies with Part 15 of the FCC rules. 
 Operation is subject to the following two conditions:
 (1) This device may not cause harmful interference, and, 
 (2)  This device must accept any interference received,
         including interference that may cause 
         undesired operation.
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Follow the steps below to set up a new Chlorine Analyzer System. Refer to the individual component manuals for detailed information.

Step 1. Mount the panel on a vertical fl at surface using appropriate hardware.

Step 2. Open the wiring enclosure and wire input power. 
(see page 8: Wiring Input, page 9: Wiring Output, and page 10: Electrical Box Wiring Schematic)

Step 3. Wire any 4 to 20 mA and relay output.
Step 4. Remove sensor access plugs from the fl ow cell. (Figure 1)

If the optional pH sensor is NOT used, do not remove the left-side plug from the fl ow cell.
Step 5. Remove the protective cap from the chlorine electrode. 

(Keep the electrode cap in a safe place for future use. It is recommended to use the cap to protect the sensor during 
the removal of the electrode for cleaning or maintenance of the fl ow cell)

Step 6. Complete Sensor Preparation (see page 11) and install the chlorine sensor into the electronics. 
(see page 12: Sensor Installation) Install the chlorine electrode into the fl ow cell. 
The chlorine sensor is installed in the right-side access port, optional pH sensor is installed in the left-side access port.

NOTE: All new chlorine and pH sensors require calibration during the start up of a system and throughout the life of the sensor. 
A new chlorine sensor requires a conditioning period of up to 4 hours with power on and chlorinated water fl owing past 
the sensor prior to calibration. See page 24: Chlorine Sensor Calibration, for chlorine calibration and set up procedure.

NOTE: If a Free Chlorine sensor without optional pH sensor is used, pH value must be 
"hard-coded" into the system (See page 23: Manual pH compensation). 
If optional pH sensor is installed, see page 22 to complete pH Sensor Calibration.

Step 7. Repeat step 5 and 6 if the optional pH sensor is being used.
Step 8. Install the infl uent water source to the "Inlet Port" nipple assembly of the fl ow 

cell. Install 3/8-inch tubing and secure with a hose clamp. 
(Not included. See page 13: Tubing Connections)

Step 9. Install 3/8-inch tubing and secure with a hose clamp on the "Drain" port and 
direct the tube to a proper drain. (Not included)

Step 10. Verify the inlet and drain ball valves are in the open position and 
the sample port is in the off position. (See page 13: Tubing Connections)

Step 11. Turn on the infl uent water source and check the system for leaks.
Step 12. Apply power to the system and allow system to initialize. Calibrate per 

instructions. 
(See page 24: Chlorine Sensor Calibration and page 22: pH Sensor Calibration)

NOTE: As factory default, the 4630-X Chlorine Panel Assembly is set to measure Free Chlorine. If a 2632 Chlorine Dioxide 
sensor is to be used to convert to a Chlorine Dioxide Panel Assembly, refer to the 8630-3 OPTIONS Menu on page 20.

Do not turn on power at this time.

1. Chlorine panel assembly
 a. Built-in pressure regulator 15 to 120 psi.
 b. 3/8 inch hose barb connectors.
2. 1 each 2630 series Free Chlorine sensor or 2632 Chlorine Dioxide sensor; each with protective cap
 a. 1 spare membrane cap
 b. 2 bottles of electrolyte solution
 c. 1 syringe needle (taped to bottle)
 d. 1 syringe
3. 1 each Flat pH sensor 3-2724-00 (159 001 545) (3-4630-11, -21, -31 and 3-4632-11 models only)
4. Manual package
 a. English panel assembly manual
 b. CD with multi-language manuals
 c. Wall mounting hardware
 d. Drill template
5. 1 each North American Type B power cord
6. Customer supplied
 a. 3/8" hose input and drain
 b. Hose clamps

Sensor access plugs 

Figure 1

  Quick Start

  System Inventory
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Power cable conduit

Amperometric chlorine 
sensor electronics

3-2650-7 (159 001 670)

Flow cell block

Flow cell O-rings

Vent
Cap

Output conduits

Transmitter
3-8630-3P (159 001 673)

Wiring enclosure

Flow rate indicator

Flow range limits

Flow regulator with strainer

Inlet port

Drain port
(3/8 inch hose)

Sampling port

pH sensor
electronics

 3-2750-7 (159 001 671)

pH electrode
3-2724-00 (159 001 545)

Quick disconnect plug
(3/8 inch hose)

2000-3825*

Quick disconnect
2000-2525*

3/8" Hose barb
2000-3804*

3/8" Ball valve
4300-5225*

Chlorine electrode
3-2630-X (Free Chlorine)

3-2632-1 (Chlorine Dioxide)

* Contact factory for quote

  Panel Assembly
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Flow cell front block

Disc spring (2700-0003)*

Spacer ring
Stainless steel fi lter

Pressure regulator

Pressure regulator outer O-ring (large)

Pressure regulator outer O-ring (small)
Flow cell O-rings (4 segments)

Flat washer

Flat washer*

Disc spring (curved washer)

Knurled thumb nut (1700-2512)*

Flow cell bolt (2490-0554)

Included in kit 3-4630.390
Item Quantity
Flow cell nut 6
Flat washer 15
Disc spring 9
Knurled thumb nut 3
Flow cell bolt 6

Flow cell nut

Flat washer

Flow cell back block

Regulator Assembly
(3-4630.391)
(159 001 689)

Flow Cell
Rebuild Kit
(3-4630.390)
(159 001 688)

*Not included with 
3-4630.392 (159 001 690)

3-4630.392
(159 001 690)

  Component Identifi cation: Flow Cell
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NO

• Bright light can promote algae growth.  Indoor mounting is recommended.
• If the system is mounted outdoors, an outdoor enclosure for the whole system must be 

used to protect the electronics and fl ow cell from light, rodents, insects and dirt.
• Mount the panel according to local electrical, building, and/or plumbing codes and 

seismic requirements.
• Use four 6 mm (¼ in.) diameter screws or bolts of suffi cient length to mount the panel to 

a sturdy vertical surface.  A mounting template is provided.
• Allow clearance on the sides and bottom for service to the unit.
• Keep panel system electronics and enclosure away from dripping water.
• The panel must be mounted vertically in an upright position.

Do not mount in direct sunlight.

  Mounting
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Input for
100-240 VAC

100 to 240 VAC input
    Standard AC confi guration

12 to 24 VDC Input Wiring Conversion
• If the power source supplied to the system will be 12 to 

24 VDC instead of 100 to 240 VAC, disconnect the red 
and black output wires from the power supply (Figure 3) 
and connect your UL approved limited-energy DC power 
supply (Figure 4), using an insulated nylon parallel splice 
connector such as T&B part number 2C-12 or equivalent.

• Insert input power wiring into the pre-drilled access hole 
on the left side of the electrical box using the appropriate 
conduit adapters to maintain the Type 4X rating. 
(Customer may have to remove the supplied conduit 
connectors.)

• A switch or circuit breaker rated at 5 amps DC shall be 
included in the building installation.

• Install the circuit breaker in close proximity to the 
equipment and within easy reach of the operator.

• Mark the circuit breaker as the disconnecting device for 
the equipment.

Power Supply Terminal Identifi cation
Terminal Name Description

V. ADJ Voltage 
adjustment

Adjusts within ±10%; turning clockwise 
increases output voltage

DC ON  Operation 
indicator 

Green LED is lit when output voltage 
is on

+V, –V   DC output 
terminals 

+V: Positive output terminal
–V: Negative output terminal 

 L, N  Input 
terminals

Accepts a wide range of voltages and 
frequencies (100 to 240 VAC DC input)

100 to 240 VAC Input Wiring
• Open the electrical box by loosening the four corner 

screws of the front cover.
• Insert input power wiring into the pre-drilled access hole 

on the left side of the electrical box using appropriate 
conduit adapters to maintain the Type 4X rating. 
(Supplied conduit connectors may have to be removed.)

• Install the input power wires into the proper terminals 
on the power supply (Figure 2). Use only 12 to 26 AWG 
copper wiring.

• Recommended torque for the terminals is 7 lb-in.

NOTE:  When using alternate power supply 
7300-7524 (159 000 687):

• Use 10-24 AWG copper wiring, 105 ˚C, torque 4.4 lb-in.

Figure 2

System Input Power
• The panel system is pre-wired with an auto switching power 

supply that is rated for 100 to 240 VAC 50/60 Hz input.
• Wire with NEC Class I, 300 volt, 105 C wire.
• A switch or circuit breaker rated at 15 amps AC shall be 

included in the building installation.
• Install the circuit breaker in close proximity to the 

equipment and within easy reach of the operator.
• Mark the circuit breaker as the disconnecting device for 

the equipment.
• Grounding: The protective ground terminal must be 

bonded to protective earth in the host equipment.

WARNING
This panel system is 
wired for AC voltages 
that can injure or kill. 

Wiring should be performed by 
qualifi ed personnel only.
Disconnect AC power before opening wiring enclosure.

Figure 3

+
–

Figure 4

Part # 7300-0024 (159 001 693) shown.
Actual power supply may differ from Figure 2.

Follow all local and government recommendations and 
methods for installation of electrical connections to and 
between the system and other devices.

  Wiring Input
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WARNING
This panel system is 
wired for AC voltages 
that can injure or kill. 

Wiring should be performed by 
qualifi ed personnel only.
Disconnect AC power before opening wiring enclosure.

Follow all local and government recommendations and 
methods for installation of electrical connections to and 
between the system and other devices.

Wiring Label Legend

Ground Earth Ground. Attach 4 to 20 mA loop cable 
shield wire here to help eliminate possible noise.

Loop 1 4 to 20 mA Loop #1
Loop 2 4 to 20 mA Loop #2
Relay 1 Relay Output #1

NC Relay Normally Closed (contact) when
de-energized

C Common

NO Relay Normally Open (no contact) when
de-energized

Relay 2 Relay Output #2 (terminals same as Relay #1)

Output Connections
• Use the wiring enclosure terminal block for output wire 

connections. Do not wire directly to the transmitter.
• Recommended torque for the terminals is 7 lb-in.
• Do not run 4 to 20 mA loop cables in the same conduit as 

the power or other high voltage wiring.
• Remove one installed jumper wire (from both of its terminals)

on the terminal block in the enclosure for each loop device 
connected. Replace the jumper if you later remove your 
loop device. If only one loop device is connected, remove 
just one jumper wire from its two terminals.

• The panel system uses an active loop output wired to the 
enclosure terminal block.

• If connecting to a PLC, use the PLC's passive input.
• The transmitter must have a jumper wire or loop 

device always connected to Loop 1.

+
-

+
-

    1  2  3  4  5  6  7  8  9  10 11 12

+  –
NC   C   NO NC   C   NO      A       B

LOOP  1

LOOP  2

RELAY  1

RELAY  2

FLOW SW

+  –

PLC Terminals 

Channel 2
4 to 20 mA

Channel 1
4 to 20 mA

Red

Black

Red

Black

PLC dual channel connection

Wiring a 4 to 20 mA loop device

    1  2  3  4  5  6  7  8  9  10 11 12

+  –
NC   C   NO NC   C   NO      A       B

LO
O

P 
 1

LO
O

P 
 2

R
EL

AY
  1

R
EL

AY
  2

FL
O

W
 S

W

+  –

Jumper wire removed

to 4 to 20 mA
 loop device

  Wiring Output
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Loop 2 -

Loop 2 +
System Power Loop 1 -

System Power Loop 1 +
AUX Power -

AUX Power +

Relay 2 (N.O.)
 

Relay 2 (COM)

Relay 2 (N.C.)

Relay 1 (N.O.)

Relay 1 (COM)

Relay 1 (N.C.)

Ground

Digital (S3L)

V+

Ground

Digital (S3L)

V+

Transmitter
Terminals

Signet Chlorine Sensor Electronics
3-2650-7 (159 001 670)

10
9
8
7
6
5
4
3
2
1

GND

10
9
8
7
6
5
4
3
2
1

GND

NO

COM RELAY 2

NC

NO

COM RELAY 1

NC

– LOOP 2

+ LOOP 2

– LOOP 1

+ LOOP 1

EARTH GROUND

Black

White

Yellow

Red

Signet pH Sensor Electronics
3-2750-7 (159 001 671)

Black

Black

Black

Black

Black
Black

Black

Black

Red

Black

White

Red

Black

White

GND
N
L

– V
+V

Power Supply
24 VDC

Terminal
Block

3-8630-3P (159 001 673) Customer Wiring

  Electrical Box Wiring Schematic
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Avoid skin or eye contact with electrolyte solution.
Wear rubber gloves and goggles.
* Material Safety Data Sheets (MSDS) are available online at www.gfsignet.com.

Initial Fill Procedure:
When adding electrolyte, be prepared for an accidental spill.
Working near a sink is recommended.

1. Remove the protective bottle from the end of the electrode.
2. Remove the membrane cap from the front of the sensor.

Note:   When new sensors are shipped, the membrane cap is not tightened to 
the sensor.

3. Fill supplied syringe with electrolyte solution.
Additional caution should be taken when handling Chlorine Dioxide electrolyte solution.

4. Place the electrode on a level surface.
5. Insert syringe needle fully into one of the eight electrode holes while injecting with 

electrolyte solution. Slowly injecting the electrolyte solution into the sensor to avoid 
introducing air bubbles. The electrode holds approximately 14 milliliters of solution. 
Slowly fi ll until solution begins to fl ow out of holes. Do not allow the solution to run 
down the electrode and wet the electrical contacts in the DryLoc connector.

6. Slowly screw on the membrane cap fi nger tight. Do not use tools. To avoid damage 
and contamination, do not touch the white membrane surface on the membrane cap.

• Chlorine sensors are shipped without internal electrolyte solution.
• Prior to installation and supplying power, Chlorine sensors must be fi lled with the 

appropriate internal electrolyte solution.
• Verify the correct electrolyte solution is utilized with the corresponding sensor.
• Free Chlorine and Chlorine Dioxide sensor require different electrolyte solutions.

2630 Free Chlorine Electrode
2632 Chlorine Dioxide Electrode

NOTE: Inspect and change the 
membrane cap if damaged.  
See page 36, Maintenance, for 
cleaning procedure.

A new chlorine electrode or one that has had the membrane cap changed must be 
calibrated. See page 24, 8630 Transmitter information on calibration of the chlorine 
sensor. A diethyl-p-phenylenediamine (DPD) colorimeter test kit (not included) is required 
for sensor calibration. A sample is taken and analyzed with the DPD test kit, then this 
value is entered into the Signet 8630 transmitter.
• Calibrate after a membrane cap change (requires 2 hour stabilization time).
• Calibrate after the internal electrolyte is replaced (requires 2 hour stabilization time).
• Check calibration one day after sensor is placed in service.
• Check calibration weekly to monthly depending on process requirements.

The sensor membrane and internal electrolyte solution must be replaced over the life 
of the electrode. To maintain accurate chlorine measurements, GF Signet recommends 
that the internal electrolyte be replaced every 3 to 6 months, or when Chlorine readings 
drift low and/or cannot maintain a calibration longer than 5 days. Actual interval between 
maintenance of the sensor will be dependent on the actual applications, chlorine level and 
contaminates in the water.  See Appendix page 36; Maintenance and Storage.
Keep spare membrane caps available. Membrane caps carry no warranty.

To maintain accurate chlorine measurements, GF Signet recommends the internal 
electrolyte be replaced and the gold-plated sensor electrode be properly polished every 
3 to 6 months. See Appendix, page 37.

  Chlorine Sensor Calibration

  Chlorine Sensor Preparation

  Chlorine Sensor Maintenance

CAUTION: 
DO NOT touch the gold-plated tip 
or the membrane of the sensor.
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• Remove sensor access plugs from the fl ow cell (pg. 4, Figure 1).
 Note:  Chlorine Sensor Preparation must be completed prior to installation, see page 11.
• Holding the 3-2750-7 (159 001 671) or 3-2650-7 (159 001 670) electronics inverted, open the DryLoc® connector by 

turning the upper locking ring ¼-turn counter-clockwise.
• Insert the electrode facing up. Turn the locking ring ¼-turn clockwise to lock the electronics in place.
• The mechanism will “click” when it is locked.
• Install the complete assembly into the fl ow cell and ensure the key on the electrode aligns with the key slot on the fl ow cell.

DryLoc® Connection to Sensor Electronics

Locking RingLocking Ring

LockLock

3-2724-00
(159 001 545)
pH electrode

3-2630-X
FCL electrode

3-2750-7
(159 001 671)
pH electronics

3-2650-7
(159 001 670)
Amperometric Electronics

3-2632
ClO2 electrode

Lubricate O-rings with
a non-petroleum 
based, viscous 
lubricant (grease) 
compatible with the 
system.

Avoid skin or eye contact with electrolyte solution.
Wear rubber gloves and goggles. Safety Data 
Sheets (SDS) are available online at www.gfsignet.
com.

Do Not Use Lubricant or Sealing Tape on Threads.
Do Not Overtighten. Do Not Use Tools.
Do Not Drop or Strike the Membrane.

Signet 3-2724-00
(159 001 545)

Flat pH Electrode

Signet 3-2630-X
Signet 3-2632
Chlorine Electrode

Signet 3-2650-7
Electronics

Signet 3-2750-7
pH Electronics

  Sensor Installation
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IN
OUT

pH Cl

OK

Flow Rate
The fl ow rate is in the proper range when the fl oat is 
between the Min. and Max. markers on the fl ow cell. 
The fl ow range limits are 30.24 to 45.36 L/h (8 to 12 gal/h).

Use suitable 9.5 mm (3/8 in) ID tubing that is rated for your 
inlet pressure. Use hose clamps.

Valve position for start up and normal use.
Note: Turn off inlet valve fi rst when stopping water fl ow. 
• The drain tube must be positioned lower than the infl uent 

water source to allow proper fl ow through the fl ow cell. 
The fl ow cell must drain by gravity, not system pressure.

• When testing, allow the sample to fl ow for a few seconds 
before collection.

Inlet Quick Release Connection

Press down gray plunger to release. Water fl ow is 
automatically shut off when disconnected.

For Low Flow applications (fl ow less than 1 bar/15 psi), the 
Flow Regulator can be removed and the fl ow adjusted using 
the Flow Cell ball valve. (NOTE: The inlet hose barb will also 
need to be changed. Contact factory for details.)

Inlet Drain
(to outlet)

Sampling port
(fl ow off)

  Tubing Connections

  Water Flow
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The example View menus below return to the default display after 10 minutes.

FCl:  2.67 ppm
7.10 pH  25.3 °C

View chlorine, pH and Temperature values from the sensor.
FCl = free chlorine, ClO2 = chlorine dioxide.

Cl Raw:  103.8 nA
pH Raw:  -5.9 mV

Chlorine nanoamps (nA), and pH raw millivolt (mV) signals from the electrodes.
For reference only.

Loop 1   10.68 mA
Loop 2    8.56 mA

Displays the actual current output in milliamps (mA) of the electrode 
assigned to Loop 1 and Loop 2. (Scaled as a 4 to 20 mA signal)

Last CAL:
05-01-17 View of the last system calibration date: Manually entered by the operator. 

8630
Chlorine

• The View Menu is displayed during normal operation.
• To select a VIEW display, press the ▲ or ▼ arrow keys. The selections will scroll in a continuous loop. There are four pages

 to view.
• Changing the VIEW display does not interrupt system operations.
• No key code is necessary to change display selection.
• The VIEW MODE will not allow access to the CALIBRATION or OPTION menus, preventing accidental changes to the 

application settings by an unauthrized person.
• All menus time-out after 10 minutes and return to the previous operating display.
• When editing the CALIBRATE or OPTIONS menus, the transmitter will return to the default display after 10 minutes and then the 

VIEW menu in another 10 minutes if no activity occurs.

 CAUTION!
•   Remove power to unit before wiring input or output connections.
•   Follow instructions carefully to avoid personal injury or damage to the transmitter.

The Signet 8630 ProcessPro® Chlorine Transmitter displays and transmits free chlorine or chlorine 
dioxide, along with pH information when connected to Signet Amperometric Chlorine Sensors and 
a Signet pH Sensor.

Features of the 8630 include:
• Displays Free Chlorine measurements from 0.02 to 20 ppm (parts per million) or Chlorine 

Dioxide measurements from 0.02 to 2 ppm.
• Specifi es all compatible chlorine sensors.
• Automatic pH and temperature compensation or manual pH input to calculate accurate 

free chlorine measurements.
• Simple setup and easy customization with the 4-button keypad.
• Dual 4 to 20 mA outputs with two built-in SPDT mechanical relays.
• Easy viewing via the bright backlit LCD display.

  8630 Chlorine Transmitter

  8630 View Mode
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The 8630-3 (159 001 662) has two menus the user can edit: CALIBRATE and OPTIONS
• The CALIBRATE menu allows you to calibrate and initialize sensors, defi ne current loops and set relay functions.
• The OPTIONS menu allows you to set sensor type, adjust and test current loops, test relays and more.

Press the ▲ and ▼ keys simultaneously 
while any element is fl ashing. This will recall 
the last saved value of the item being edited 
and will return you to Step 3.

Made an Error?
Press the ▲ and ▼ keys simultaneously 
after saving the last setting to return to
View menu.

Finished Editing?

  8630 Editing Procedure

Step 1.   Press and hold the ENTER key:
  •  2 seconds to select the CALIBRATE menu.
  •  5 seconds to select the OPTIONS menu.

Step 2.   Enter the Key Code.
  The Key Code is ▲-▲-▲-▼ keys in sequence.
  •  After entering the Key Code, the display will show the fi rst item in the selected menu.

Step 3.   Scroll the menu in a loop with the ▼ or ▲ arrow keys.

Step 4.   Press the ► key to select the menu item to be edited.
  •  The fi rst display element will begin fl ashing.

Step 5.   Press the ▲ or ▼ keys to edit the fl ashing element.
  •  The ► key advances the fl ashing element.

Step 6.   Press the ENTER key to save the new setting and return to Step 3.
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Step 6. Last Cal:
    Saving 
Last Cal:
   06-02-17

Step 4. Last Cal:
    05-01-17    > 

Step 1. 2s

(Hold)

5s
OPTIONS
menu

ORENTERENTER

Example

Step 3. Cl Zero
Calibration:    >  

Last Cal:
    05-01-17    > 

Step 5. Last Cal:
   05-01-17   
Last Cal:
   06-01-17
Last Cal:
   06-02-17
Last Cal:
   06-02-17

ENTERENTER

CALIBRATE menu

Step 2. CALIBRATE:----
Enter Key Code  

CALIBRATE:---
Enter Key Code

CALIBRATE:--
Enter Key Code

CALIBRATE:-
Enter Key Code

Cl Zero
Calibration:    > 

Example: Calibration

Access the CALIBRATE Menu:
Press and hold the ENTER key for 2 seconds to access 
the CALIBRATE menu.

Edit the fl ashing element:
This is the edit mode.
The ▲ or ▼ keys change the fl ashing element.
The ► key advances the fl ashing element in a 
continuous loop. In this example, the "Last Cal" date 
was changed from 05-01-17 to 06-02-17.
All output functions remain active during editing.
Only the fl ashing element can be edited.

Press ENTER to save the new value.
When you have set your desired value, pressing the 
ENTER key stores the value on the screen, making it 
immediately available to output functions and exits you 
back to Step 3.

Enter the Key Code:
The CALIBRATE and OPTIONS menus require a 
password (KEY CODE). Pressing the ▲, ▲, ▲, ▼ keys 
in sequence unlocks the display and the fi rst menu item 
will appear. If no key is pressed for 5 minutes while the 
display is showing "Enter Key Code", it will return to the 
VIEW menu.

Scroll the Menu:
Press the ▼ or ▲ keys to scroll through the Menu.
While in this mode, pressing the ▲ and ▼ keys 
simultaneously will return the display to the VIEW menu.
If no key is pressed for 10 minutes, the display will 
return to the VIEW menu.

Select the item to be edited:
In this example, "Last Cal" (last calibration date) is 
chosen to edit. Pressing the ► key selects the menu 
item and enters the screen into edit mode.

ENTERENTER

ENTERENTER

  8630 Editing Procedure
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  Cl Zero
Calibration:    >

When > is pressed, the “live” readings are shown. The nA value is displayed, but cannot be 
edited and is used for diagnostic and calibration purposes. When in Edit Mode, pressing Enter 
stores the displayed value as your zero reference.

Cl In Process
 Calibration:   > Enter process chlorine value determined from a DPD test kit here.

Cl Temperature
 Calibration:   >

Enter process temperature from a reference thermometer: °C or °F. Units are set up in the 
Options Menu.

Reset Cl to
Factory Cal:    >

This menu resets Cl readings, Zero Calibration and temperature back to Factory Calibration. 
WARNING! User entered Cl calibration settings will be lost.

pH Standard
Calibration:    > Set pH standard value. This applies a linear offset to the pH measurement.

pH Slope
Calibration:    >

Applies a slope to the pH measurement. The slope and standard value must be at least
2 pH units apart.

Reset pH to
Factory Cal:    >

Reset pH standard, slope or back to Factory Calibration.
WARNING! User entered pH calibration settings will be lost.

Chlorine Units:
     ppm        > This is the fi rst screen. Choose units of measurement: ppm or mg/l.

Loop 1 Source:
  Chlorine      > Choose chlorine or pH for this 4 to 20 mA current loop.

Loop 1 Rng: ppm
  0.00   5.00  >

Select the minimum and maximum values for the current loop output. Units are derived from 
Loop 1 Source. If the Source 1 is changed, be sure to re-edit this page.

Loop 2 Source:
    pH          > Choose pH or chlorine for this 4 to 20 mA current loop.

Loop 2 Rng: pH
 00.0  14.00   >

Select the minimum and maximum values for the current loop output. Units are derived from 
Loop 2 Source. If Source 2 is changed, be sure to re-edit this page.

Calibrate Menus
Factory settings shown Description

Current Output Functions

NOTE:
For greater accuracy it is recommended that the initial calibration of the system should be in the following order:
1. Temperature
2. pH electrode (if optional pH sensor is installed. If manual pH sensor is selected enter the pH value into the option menu prior 

to calibrating the chlorine sensor)
3. Chlorine sensor.

• Although the Calibrate Menu can be navigated upwards or downwards, it is best to navigate downwards when 
editing Current Loop and Relay settings as previous entries can infl uence subsequent menus.

• Chlorine and pH calibration screens will be shown only when a valid sensor is detected.

The menus below are displayed here in the order seen when scrolling down through the Calibrate Menu.

NOTE: The next two pH calibration screens will be shown only when a valid pH sensor is detected.

2s

(Hold)
ENTERENTER

Press the ► key to enter Edit mode. Press the Enter key to save
your settings.

ENTERENTER
Press the ▲ or ▼ Arrow
key to scroll through the menus.

  8630 Calibrate Menu
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If Pulse Mode was chosen:

Relay 2 Mode:
      Off       >

Choose Relay 2 mode of operation: Off, Low, High, Window, or Pulse.
To disable this relay choose Off.

Relay 2 Source:
     pH         >

Choose pH or chlorine for Relay 2. This menu screen and all subsequent Relay 2 screens 
below do not appear if Relay 2 Mode is set to Off.

Relay 2 Setpnt:
    0.00 pH     >

In Low or High Mode, Relay 2 will be activated when the process reaches this value.
Units of measure refl ect Relay 2 Source.

Relay 2 Hys:
    0.20  pH    >

Relay 2 will be deactivated at Relay 2 Setpoint ± this hysteresis setting depending on High or 
Low Setpoint selection.

Relay 2 Delay:
      0.0 secs  >

Set the time delay for Relay 2 to activate after reaching the Setpoint.
Range: 0 to 6400 seconds.

If Low or High Mode was chosen:

Relay 1 Hys:
    0.20  ppm   > Relay 1 will be deactivated at Range setpoints ± this hysteresis setting.

Relay 1 Delay:
    0.0  secs   > Set time delay for Relay 1 to activate after reaching the setpoints set in Relay 1 Range.

Relay1 Rng: ppm
  0.00  5.00   > Enter the range where Relay 1 will activate above and below this setpoint.

Relay1 PlsRate:
120 pulses/min  > Set the maximum pulse rate. Range: 1 to 400 pulses/min.

Relay 1 Mode:
    Off         >

Choose mode of operation: Off, Low, High, Window, or Pulse. If Off, all subsequent Relay 1 
functions are inactive and not visible.

Relay 1 Source:
     Chlorine   > Choose chlorine or pH for Relay 1.

Relay 1 Source:
     Chlorine   > Choose chlorine or pH for Relay 1.

Relay 1 Source:
     Chlorine   > Choose chlorine or pH for Relay 1.

Relay 1 Setpnt:
    0.00 ppm    >

In Low or Hi Mode, Relay 1 will be activated when the process reaches this value.
Units of measure refl ect Relay 1 Source.

Relay 1 Hys:
    0.20  ppm   >

Relay 1 will be deactivated at Relay 1 Setpoint ± this hysteresis setting depending on High or 
Low Setpoint selection.

Relay 1 Delay:
      0.0  secs >

Set the time delay for Relay 1 to activate after reaching the Setpoint.
Range: 0 to 6400 seconds.

Relay Functions

If Low or High Mode was chosen:

If Window Mode was chosen:

Relay1 Rng: ppm
  0.00  5.00   > Enter the range where Relay 1 will activate above and below this setpoint.

Verify all relay settings if the Relay Source is changed

  8630 Calibrate Menu
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Relay2 Rng: pH
  0.00  14.0   > Enter the range where Relay 2 will activate above and below this setpoint.

Relay2 PlsRate:
120 pulses/min  > Set the maximum pulse rate. Range: 1–400 pulses/min.

If Pulse Mode was chosen:

   Find New
    Sensor(s):  > Required only when a new sensor is changed while the power is on. Choose Yes or No.

Last Cal
    10-18-09    > Edit the calibration date.

End of Calibrate Menu 

Relay 2 Rng: ppm
  0.00  5.00   > Enter the range where Relay 2 will activate above and below this setpoint.

Relay 2 Hys:
    0.20  ppm   > This relay will be deactivated at Relay 2 Range setpoints ± this hysteresis.

Relay 2 Delay:
      0.0  secs >

Set the time delay for Relay 2 to activate after reaching the setpoints set in the 
Relay 2 Range.

If Window Mode was chosen:

Relay 2 Source:
     pH         > Choose pH or chlorine for Relay 2.

Relay 2 Source:
     pH         > Choose pH or chlorine for Relay 2.

  8630 Calibrate Menu
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Options Display
(Factory settings shown) Description

   Contrast:
       3        > Adjust the LCD contrast for best viewing. A setting of 1 is lower contrast, 5 is higher.

Cl Sensor Type:
    Free Cl     > Select the chlorine sensor: Free Cl or ClO2.

   pH Input
     Sensor     >

Choose Manual or Sensor. If Sensor is chosen, the pH value from the connected pH sensor will be 
used. Choose Manual to enter a pH value manually when no sensor is connected or if measuring
chlorine dioxide.

Temp Display:
       °C       > Choose units of °C or °F.

   Averaging:
       Off      >

OFF gives the fastest response to input changes. LOW = 4.5 seconds, HIGH = 9 seconds of averaged 
response. Increase averaging to steady the display.

Manual pH Value
    7.000 pH  Enter your pH value here if a pH sensor is not connected.

If Manual pH input was chosen:

Test Loop 1:   
                >

Press UP or DOWN keys to manually output any current value from 3.6 mA to 21.00 mA to test 
Loop 1 output.

Test Loop 2:   
                >

Press UP or DOWN keys to manually output any current value from 3.6 mA to 21.00 mA to test 
Loop 2 output.

Loop 1 Adjust:   
      4.00 mA   >

Adjust the minimum current output for Loop 1. The display value represents the precise 
current output. Range: 3.80 mA to 5.00 mA.

Loop 1 Adjust:
     20.00 mA   > Adjust maximum current output for Loop 1. Range: 19.00 mA to 21.00 mA.

Loop2 Adjust:   
     4.00 mA    > Adjust the minimum current output for Loop 2. Range: 3.80 mA to 5.00 mA.

Loop2 Adjust:   
    20.00 mA    > Adjust maximum current output for Loop 2. Range: 19.00 mA to 21.00 mA.

   Decimal:
    ***.**      > Select the decimal point for the display. Maximum of 2 decimal places.

Press the ► key to enter Edit mode. Press the Enter key to save
your settings.

The menus below are displayed here in the order seen 
when scrolling down through the Options Menu.

5s OPTIONS menu

(Hold)
ENTERENTER

ENTERENTER
Press the ▲ or ▼ Arrow key to 
scroll through the menus.

  8630 Options Menu
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Zero Cal: ppm&nA
 xxx.xx  xxxx.x View user entered Zero Calibration data in ppm and nA.

Temp at Cal:
     xxxx.x °C Temperature recorded during user In-Process Calibration.

pH at Cal:
     xxx.xx pH pH value recorded during user In-Process Calibration.

In Proc: ppm&nA
 xxx.xx  xxxx.x View user In-Process Calibration value when it was entered in the Calibrate Menu.

Temp Offset:
     xxxx.x °C Temperature offset calculated from user entered temperature calibration from Calibrate Menu.

Elapsed Time:
   xxxxx.  hrs Total hours of operation.

Low & High: °C    
-xxxx.x   +xxxx.x Lowest and highest temperatures the Cl sensor has been subjected to during operation.

Test Relay 1:   
                >

Press UP or DOWN keys to manually toggle Relay 1 Off and On. The left LED on the front of
the transmitter confi rms operation.

Test Relay 2:   
                >

Press UP or DOWN keys to manually toggle Relay 2 Off and On. The right LED on the front of 
the transmitter confi rms operation.

Read Sens Data:   
      No       >

If "YES" is selected the following (Read Only) screens will be shown.
If "NO" then this menu ends the Options Menu.

Cl Sensor S/N:
   xxxxxxxxx View the sensor serial number.

Cl Type & Range:
 2630  xxx.x ppm Identify the chlorine sensor type connected and its ppm range.

If Yes was chosen:

End of Options Menu 

  8630 Options Menu
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Refer to your pH sensor manual.

The pH sensor needs to be calibrated against two different pH 
buffer references to calibrate the offset (standard) and slope. 
Electrode offset is any deviation from 0 mV in a pH 7 buffer at 
25 °C. Slope is the ratio of mV to pH units.
• Always keep any output devices offl ine when calibrating.

Set pH Offset (Standard)
The transmitter must be powered on and the pH sensor must 
be connected.
1. Turn off the water fl ow through the system, then remove 

the pH sensor from its fl ow cell.
2. Using pH buffer 7.0, place enough pH buffers into 

clean calibration cups, supplied with the pH calibration 
kit 3-2700.395 (159 001 605), to cover the tip of the 
electrode.

3. Pour distilled water in another clean cup for rinsing the 
electrode between buffers.

4. Rinse probe, place the pH sensor in the pH 7.0 buffer 
and allow the mV reading to stabilize.

Example: Set pH Standard to 7.00
5. Go to the Calibrate Menu.
6. Scroll down ▼ 5 menus to the pH Standard menu.
7. Press ► to enter Edit Mode.
8. Enter the pH value of the buffer that the electrode is 

placed in; 7.00 in this case. 
9. Press the Enter button to save the setting.
10. Exit to the View Menu. ▲▼

E X A M P L E

If a pH sensor is part of the system, use the Calibration 
Kit 3-2700.395 (159 001 605) prior to initially installing 
the sensor and during its normal lifetime. If a pH sensor is 
not available but pH determination is necessary, measure 
process pH with a separate test and enter the value in the 
Options Menu.

NOTE: The pH sensor will not calibrate when the mV value 
exceeds 50 mV from the original new electrode specifi cation.  
Electrode: pH 4.01 = + 177 mV

NOTE: Temperature must be calibrated before calibrating the 
pH sensor. See Chlorine Sensor section.

View Menu

Calibrate Menu

FCl:  2.67 ppm
7.11 pH  25.3°C

pH Standard
Calibration:    >

pH Standard Cal:
07.00 pH/ 0 mV

pH buffer value 
entered here

6

7

8

Step 4

E X A M P L E

ENTERENTER

5X

5

ENTERENTER
2s

(Hold)

  pH Sensor Calibration

In order to properly calibrate a GF Chlorine system it is important to follow the process below: 
1 - Calibrate Temperature 
2 - Calibrate the pH electrode (if a pH electrode is not being used, refer to page 23 , Set manual pH Compensation) 
3 - Calibrate Chlorine sensor

Calibration
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Set Manual pH Compensation

If the pH of the application is stable, then the pH of the 
application can be entered manually and will be used to 
calculate the free chlorine measurements.

NOTE: Chlorine Dioxide does not require pH compensation.

Example: Change the pH input from Sensor to Manual 
and enter a pH value of 7.22

1. Go to the Options Menu.
2. Scroll down ▼ 2 menus to the pH Input menu.
3. Press ► to enter Edit Mode.
4. Choose Manual and press Enter.
5. Scroll down ▼ 1 menu to the Manual pH Value menu.
6. Press ► to enter Edit Mode.
7. Enter your new process pH value: 7.22.
8. Press the Enter button to save the setting.
9. Exit to the View Menu.

E X A M P L E
E X A M P L E

View Menu

Calibrate MenupH Slope
Calibration:    >

pH Slope Cal:
04.01 pH/ +177 mV

pH buffer value
entered here

4

6

5

pH Standard Cal:
07.00 pH/ 0 mV

E X A M P L E

ENTERENTER

Options MenuStep 2

5

7

4

pH Input
     Sensor     >

pH Input
     Manual     >

pH Input
Sensor  Manual

Manual pH Value
    7.220 pH 

New pH value entered

Manual chosen

E X A M P L E

ENTERENTER

ENTERENTER

  pH Sensor Calibration

Set pH Slope
1. Remove the pH sensor from the fi rst buffer solution and 

rinse it in distilled water.
2. Place the pH sensor in a different buffer solution 

(example: pH 4.01). The pH standard and slope must be 
at least 2 pH units apart.

3. Note the pH and mV readings on the View Menu and 
allow it to stabilize.

Example: Set pH slope to 4.01

4. Scroll down ▼ 1 menu to the pH Slope menu.
5. Press ► to enter Edit Mode.
6. Enter the pH value of the buffer that the electrode is 

placed in; 4.01 in this case.
7. Press the Enter button to save the settings.
8. Exit to the View Menu.  ▲▼

9. Replace the pH sensor back into its fl ow cell.
10. Turn on the water fl ow.

The pH sensor calibration is complete.
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Chlorine sensors need to be calibrated for accuracy. 
Calibration must be done with every new sensor and 
any time a membrane cap is replaced.  After the 4 hour 
conditioning period, Temperature Calibration and 
In-Process Calibration needs to be performed. Any 4 to 20 
mA or relay output devices should be offl ine.

Chlorine Sensor Temperature Calibration
The temperature element inside the chlorine sensor needs 
to be calibrated. Use a reference thermometer to verify 
the actual temperature of the sample. This value is then 
entered  in Step 4 to calibrate the system.  After completing 
Temperature Calibration, proceed to In-Process Calibration, 
page 25.

Tip: Remove the pH electrode from the fl ow cell and insert 
the reference thermometer. If no pH sensor is being used, 
remove the cell plug to insert the thermometer. Replace the 
plug after calibration.

Example: Set the calibrated temperature to 25.3 ºC

1. Go to the Calibrate Menu.
2. Scroll down ▼ 3 menus to the Cl Temperature menu.
3. Press ► to enter Edit Mode.
4. Enter the temperature reading. Example: 25.3.
5. Press the Enter button to save the setting.
6. Exit to the View Menu.

E X A M P L E

E X A M P L E

Step 2

4

 Cl Temperature
  Calibration:  >

Cl Temp:  Cal
  +025.3 °C

Calibrate Menu

New temp. value ENTERENTER
Lowest value noted for
Zero Cal

Zero Cal:  ppm&nA
    0.20 / 001.0

  Cl Zero:
Calibration     > Calibrate MenuStep 6

8

The signal level during a Zero Point 
Calibration must be at least 1 nA lower 
than the In-Process Calibration point.

E X A M P L E

ENTERENTER

  Chlorine Sensor Calibration

Zero Point Calibration
Zero Point Calibration is only used at the factory to program 
the sensors zero calibration point. This value does not shift 
throughout the life of the electrode and does not need to 
be performed in the fi eld. After completing Temperature 
Calibration, proceed to In-Process Calibration, page 25.

For Reference Only:
The chlorine sensor needs to be calibrated against two 
chlorine references: zero chlorine and the process chlorine. 
Typically the zero point calibration is very stable. Calibration 
must be done with every new sensor and any time a 
membrane cap is replaced.

1. Keep offl ine any 4 to 20 mA devices or relay actuated 
output devices that connect to the transmitter.

2. Turn off the water fl ow and remove the powered chlorine 
sensor with the electronics still attached.

3. Place the sensor tip in distilled water.
4. Wait until the reading stabilizes, then save the 

calibration. Stirring the sensor in water is not necessary, 
but allows the signal to stabilize faster.

Example: Set the Zero Point Calibration at 1.0 nA

5. Go to the Calibrate Menu.
6. Scroll down ▼ one menu to the Cl Zero menu.
7. Press ► to enter Edit Mode. The live sensor readings in 

ppm and nA will be fl ashing. These readings cannot be 
modifi ed, but can only be saved as displayed.

8. Press the Enter button at the lowest reading to save the 
setting or press           to escape without changes.

9. Exit to the View Menu.

10. After Zero Point Calibration is complete, replace the 
sensor back into the fl ow cell and turn the water fl ow 
back on.

11. Wait until the chlorine readings stabilize once again, then 
perform a chlorine In-Process Calibration.

E X A M P L E
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  Cl In Process
 Calibration:   >

In Proc:  ppm&nA
 2.67  /  103.8

E X A M P L E

Calibrate Menu

DPD Cl ppm value
entered here

ENTERENTER

Step 5

7

The signal level during an In-Process 
Calibration must be at least 1 nA higher 
than the previous Zero Calibration point.

In-Process Calibration

E X A M P L E

1. Take a water sample from the Sampling Port (after 
purging it) from a stabilized and running system.

2. Use this sample to measure the chlorine content with 
a colorimetric DPD test kit (not included). Refer to the 
DPD kit instructions on how to perform this test.

3. Record the test results.

Example: Set the Chlorine In-Process to 2.67 ppm

4. Go to the Calibrate Menu.
5. Scroll down ▼ 2 menus to the Cl In-Process menu.
6. Press ► to enter Edit Mode.
7. Enter the chlorine reading determined from the DPD test 

into the edit screen: 2.67 ppm. The Cl ppm is editable 
and must be at least 0.2 ppm. 

8. Press the Enter button to save the setting.
9. Exit to the View Menu.

Calibration is complete for the chlorine sensor.

NOTE: For greater accuracy, it is recommended 
that the DPD test be repeated three times and 
the results averaged.

Confi gure the current loop and relay functions if applicable. 
NOTE: The current and relay outputs can be tested in the 
Options Menu.

Current Loop Settings
Current outputs are passive outputs that can be spanned in 
the forward and reverse direction. Example: 0 to 5 or 5 to 0.

Example: Set a current loop source as chlorine and the 
operational range to 0 to 5 ppm

1. Go to the Calibrate Menu.
2. Scroll down ▼ to the Loop 1 Source menu.
3. Press ► to enter Edit Mode.
4. Choose either the chlorine or pH sensor as the source 

that will control this loop: Chlorine.
5. Press the Enter button to save the setting.

6. Scroll down ▼ 1 menu to the Loop 1 Rng menu.
7. Press ► to enter Edit Mode.
8. Select the minimum and maximum process values for 

the current loop output: 0 to 5 ppm.
9. Press the Enter button to save the setting.
10. Exit to the View Menu. 

E X A M P L E

A diethyl-p-phenylenediamine (DPD) colorimeter test kit (not 
included) is required for sensor calibration. A sample is taken 
and analyzed with the DPD test kit, then this value is entered 
into the Signet 8630 transmitter.

Calibrate Menu

Set and save

Set and save

  Loop 1 Source:            
  Chlorine      >Step 2

Loop 1 Rng: ppm
  0.00   5.00  >6

E X A M P L E

NOTE:
When integrated into the 463X Chlorine Panel Assembly, 
the loop outputs are wired into Active outputs via the 
terminal strip found inside the 463X enclosure.

  Output Settings - Loops and Relays  Chlorine Sensor Calibration
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          Pulse-frequency Operation:
The transmitter can output a pulse at the rate defi ned by 
the settings in the CALIBRATE menu and the sensor input. 
The maximum pulse square wave output from the relays is 
400 pulses per minute. Example usage would be to control 
solenoid operated dosing pumps.

Example: As the process value drops below the setpoint
(4 mg/l) the output will start pulsing in relation to the process 
value, the maximum pulse endpoint and the programmed 
pulses/minute. The pulse rate will increase as the process 
value decreases and approaches the programmed endpoint. 
This functionality can be used to precisely control the 
process.

• The output will be 0 pulses/minute when the input value is 
greater than 4 mg/l.

• The output will be 35 pulses/minute when the input value is
3 mg/l.

• The output will be 100 pulses/minute when the input value 
is 1 or less.

The starting point, endpoint and maximum pulse rate are 
select    able in the CALIBRATE menu.

Mechanical Relay Functions

The 8630 relays are selectable and confi gurable and can 
be used as switches that respond when the process value 
moves above or below a user defi ned setpoint. They can 
be used for Low Alarm, High Alarm or Proportional Pulse 
triggering related to the process value. Relay functions, 
hysteresis and time delay settings are set up in the 
CALIBRATE menu and can be tested in the OPTIONS menu.

 Low Setpoint:
Relay is energized when the measured value is less than
the setpoint.

Hysteresis

Time

Low Setpoint

Process

Relay energized
Relay de-energized

Hysteresis

Time

High Setpoint

Process High Setpoint:
Relay is activated when the measured value is higher than
the setpoint.

Time

High Limit

Hysteresis

Hysteresis

Low Limit

Process

Window

 Window:
Relay is off within the window of two setpoints minus the 
hysteresis. Relay is activated when the value is higher or 
lower than the high and low setpoint.

  Output Settings - Loops and Relays
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Example: Set a relay to energize at a low setpoint of 
1.0 ppm with a time delay of 15 seconds and de-energize 
at 1.30 ppm

• Once a setting is saved it immediately becomes 
active.

1. Go to the Calibrate Menu.
2. Scroll down ▼ to the Relay 1 Mode menu.
3. Press ► to enter Edit Mode.
4. Scroll down ▼ and choose Low.
5. Press Enter.

6. Scroll down ▼ to the Relay 1 Source menu. The default 
is Free Chlorine.

7. Scroll down ▼ to the Relay 1 Setpnt menu.
8. Press ► to enter Edit Mode.
9. Set the ppm value to trigger the relay: 1.00 ppm.
10. Press Enter.

11. Scroll down ▼ to the Relay 1 Hys menu.
12. Press ► to enter Edit Mode.
13. Set the hysteresis (dead zone) for this relay. This affects 

the turn off only: 0.3 ppm.
14. Press Enter.

15. Scroll down ▼ to the Relay 1 Delay menu.
16. Press ► to enter Edit Mode.
17. Set the turn-on delay in seconds for the relay: 15 secs.
18. Press Enter.
19. Exit to View Mode.

• Relay function can be tested in the Options Menu.

Relay Settings

Relay energized
Relay de-energized

1.00

1.30

Time

Cl ppm

Time Delay

Low 
Setpoint

Calibrate MenuStep 4

6

9

13

17

Set and save

  Relay 1 Mode:            
       Low      >

Set and save

 Relay 1 Source:
     Chlorine   >

Set and save

Relay 1 Setpnt:
    1.00 ppm    >

Set and save

Relay 1 Hys:
    0.30  ppm   >

Set and save

Relay 1 Delay:
   15.0  secs   >

E X A M P L E

  Output Settings - Loops and Relays
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CAUTION!
• Remove power before wiring.
• Follow instructions carefully to avoid personal injury or 

damage to the electronics.

• Refer to the wiring diagram above to connect the 2650 cable to the terminals on the 8630 Chlorine Transmitter.
• For calibration and confi guration please refer to the 8630 Calibrate Menu discussions above.

The electronics are pre-wired from the factory to the transmitter. Refer to the following 
schematics when replacing the electronics.

8630
Chlorine

Gnd

I/O

V+

18
17
16

Signal Ground

Digital (S3L) data

+5 VDC

White

Red

Black

Shield

pH
Signet 3-2750-7
(159 001 671)

N/C

8630
Chlorine

Gnd

I/O

V+

15
14
13

Signal Ground

Digital (S3L) data

+5 VDC

White

Red

Black

Shield

Chlorine
Signet 3-2650-7
(159 001 670)

N/C

• The Signet 2650-7 Amperometric Electronics provide the polarization voltage and signal conditioning required by the Signet 
2630-X and 2632-X Sensors.

• The Signet 2750-7 pH Electronics conditions and amplifi es the output from the Signet 2724-00 pH Electrode.
• Both units output a Digital (S3L) signal to the Signet 8630 Chlorine Transmitter.

  2650-7 Amperometric and 2750-7 pH DryLoc® Electronics 

  Wiring to the Signet 8630 Chlorine Transmitter 
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Electrode Range: The electrodes must match the type and range of chlorine concentration to be measured.

Flow Rate: The electrodes must have a stable and constant fl ow of water past its membrane for accurate measurement.

When the sensor is installed in the Flow Cell Block 3-4630.392 (159 001 690), the fl ow rate range is controlled by the internal 
fl ow regulator and the fl ow rate is reduced to 30.24 to 45.36 LPH (8 to 12 US gph).

Sensor Conditioning: A new chlorine electrode requires conditioning of up to 4 hours with the electrode powered on and 
chlorinated water fl owing across the membrane to generate a stable reading. Subsequent start-ups can require an electrode 
conditioning of up to 2 hours.

The maximum allowable operating pressure must be 
less than 1 bar (15 psi). Higher pressures will damage 
the electrodes.

The electrodes should not be used in water containing 
surfactants, oils, organic chlorine or stabilizers such as 
cyanuric acid.

CAUTION!
1 Follow instructions carefully to avoid personal injury or damage to electrode.
2. Prior to installation or removal:
 a.  Disconnect fl ow through system.
 b.  Drain below sensor level.
3. Confi rm chemical compatibility before use.
4. Do not alter product construction.

These electrodes require the Signet 2650 Amperometric Electronics module to communicate with the Signet 8630-3P
Chlorine Transmitter.

Lubricate O-rings 
with a non-petroleum 
based, viscous lubricant 
(grease) compatible with 
the system.

Lubricate O-rings 
with a non-petroleum 
based, viscous lubricant 
(grease) compatible with 
the system.

  Chlorine Electrode Overview

Mfr. Part No. Code Chlorine Range Chlorine Type
3-2630-1 159 001 746 0.02 to 2 ppm (mg/L) Free chlorine
3-2630-2 159 001 662 0.02 to 5 ppm (mg/L) Free chlorine
3-2630-3 159 001 747 0.05 to 20 ppm (mg/L) Free chlorine

The Signet 2630 Amperometric Chlorine Electrodes are designed to measure 
free chlorine in ranges of 0.02 to 2 ppm, 0.02 to 5 ppm or 0.05 to 20 ppm.

  2630 Amperometric Chlorine Electrodes

The Signet 2632 Amperometric Chlorine Dioxide Electrode is designed to measure 
chlorine dioxide (ClO2) in a range of 0.02 to 2 ppm. 

The Signet 2632 Amperometric Chlorine Dioxide Electrode has an integrated 
temperature element for automatic temperature compensation.

Mfr. Part No. Code Chlorine Range Chlorine Type
3-2632-1 159 001 767 0.02 to 2 ppm (mg/L) Chlorine Dioxide

  2632 Amperometric Chlorine Dioxide Electrodes
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pH Compensation for Free Chlorine
Amperometric free chlorine sensors measure only 
hypochlorous acid. As noted in the text above and in Figure 
1, the ratio of hypochlorous acid and hypochlorite is pH 
dependent. In many applications the process pH is relatively 
stable and no correction is needed. However, where the pH 
of the water changes signifi cantly, accurate free chlorine 
measurement requires pH compensation. With the addition 
of a pH sensor, the Signet 8630 transmitter will automatically 
compensate the free chlorine reading for changes
in pH.
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Figure 1

Automatic pH Compensation and Free Chlorine
In many applications, the process pH does not signifi cantly 
fl uctuate and only a free chlorine sensor and instrument is 
necessary for accurate chlorine measurement. It is when 
the pH varies that free chlorine concentration can not 
accurately be determined without the use of automatic pH 
compensation.
The addition of the Signet 3-2724-00 (159 001 545) pH 
electrode along with its 3-2750-7 (159 001 671) preamplifi er 
to the system makes pH compensation extremely easy and 
automatic even with wide fl uctuations or high pH.
See Figure 2 for pH variation recommendations.
Example:
If the pH nominal value is 7.5 and the pH variation is ± 0.2 
then automatic pH compensation is recommended.
If the pH nominal value is 7.0 and the pH variation is ± 0.2 
then automatic pH compensation is not required.
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   Automatic pH compensation recommended
   in ranges within shaded area
=

Figure 2

NOTE: Inspect and change the membrane cap if damaged.  
See page 36, Maintenance, for cleaning procedure.

A new chlorine electrode or one that has had the membrane 
cap changed must be calibrated. See page 24, 8630 
Transmitter information on calibration of the chlorine sensor. 
A diethyl-p-phenylenediamine (DPD) colorimeter test kit (not 
included) is required for sensor calibration. A sample is taken 
and analyzed with the DPD test kit, then this value is entered 
into the Signet 8630 transmitter.
• Calibrate after a membrane cap change 

(requires 4 hour stabilization time).
• Calibrate after the internal electrolyte is replaced 

(requires 2 hour stabilization time).
• Check calibration one day after sensor is placed in service.
• Check calibration weekly to monthly depending on 

process requirements.

The sensor membrane and internal electrolyte solution 
must be replaced over the life of the electrode. To maintain 
accurate chlorine measurements, GF Signet recommends 
that the internal electrolyte be replaced every 3 to 6 months, 
or when Chlorine readings drift low and/or cannot maintain 
a calibration longer than 5 days. Actual interval between 
maintenance of the sensor will be dependent on the actual 
applications, chlorine level and contaminates in the water.  
See Appendix page 36; Maintenance and Storage.
Keep spare membrane caps available. 
Membrane caps carry no warranty.

  Calibration

  Maintenance

  2632 Amperometric Chlorine Dioxide Electrodes
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CAUTION!
1. Use appropriate eye, face, hand, body and/or respiratory protection when using chemicals or solvents.
2. Prior to installation or removal:
  a.  Depressurize and vent system.
  b.  Drain below sensor level.
3. Confi rm chemical compatibility before use.
4. Do not alter product construction.

WARNING: 3-2724-00 (159 001 545) is the only recommended 
electrode to be used in the Chlorine Analyzer System.

Removing the electrode from In-line installations

The use of this product assumes that operators are trained and are familiar with this type of device. 
They should be knowledgeable of the potential risks associated with pressurized piping systems. 
Operators MUST follow all necessary safety procedures.

In-line removal Instructions:
1. Depressurize and vent the piping system.
2. Drain the system to below sensor level.
3. Wear safety goggles or face shield during removal.
 Use all appropriate eye, face, hand, body and/or respiratory protection when working with chemicals or solvents.
4. Place a Lockout tag on the pipe when the sensor is removed for maintenance to prevent accidental opening and 

exposure to potentially hazardous chemicals.

Lubricate O-rings 
with a non-petroleum 
based, viscous lubricant 
(grease) compatible with 
the system.

Electrode Date Code
The electrode date code indicates the manufacturing date of the electrode. Electrodes should be put into service as 
soon as possible and should not remain in the box for more than two years. Over time, the storage solution (found in 
the "boot" covering the electrode tip) will evaporate or leak, allowing the delicate sensing tip and reference junction dry.

To rehydrate a dry electrode, soak it in pH 4 buffer for 24 to 48 hours. Electrodes more than 2 years old may still be 
functional, but will take longer to rehydrate. Restoration may not be effective for severely dehydrated electrodes.

K2First Digit = Month
N = January
M = February
L = March
K = April
J = May
H = June
G = July
F = August
E = September
D = October
C = November
B = December Example: K2 = manufactured in April 2017

  2724 DryLoc pH Electrode

Second Digit = Year
2 = 2017
3 = 2018
4 = 2019
5 = 2020
6 = 2021
7 = 2022
7 = 2023
9 = 2024
0 = 2025
1 = 2026
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Calibration Tips
1. The pH buffer solutions can be used for calibrating more than one sensor within a day. However, the solutions must remain 

free of debris and must not be diluted by rinse water from previous calibrations.
 Note: Use fresh buffer solutions for best results.
2. Tap or deionized water may be used to rinse the electrodes between each buffer solution.
3. Calibration solutions change value with varying temperature. Allow both the sensor and buffers to equalize with the ambient 

temperature. Sensors will not calibrate properly if the sensor is not at ambient temperature. Take note of all temperature 
variations of the sensors and the calibration solutions.

4. Do not pour used buffer solutions back into the bottle; dilute with plenty of water and fl ush them down the drain.
5. Store electrodes in pH 4 buffer when not in use.
6. Calibrate sensors on a regular basis.
7. If the pH sensor does not calibrate within acceptable limits, clean the electrode and calibrate again. If the sensor continues 

to calibrate outside of acceptable limits, the electrode is spent and must be discarded.
8. Acceptable pH ranges during calibration are as follows:

   pH 7: High:   7.8 pH =   -50 mV; Low: 6.2 pH =    50 mV
   pH 4: High:   4.8 pH =  227 mV; Low: 3.2 pH =  127 mV
 pH 10: High: 10.8 pH = -227 mV; Low: 9.2 pH = -127 mV

Electrochemical pH vs. mV Ratio
• The mV output from the electrode is created by the interaction of the 

electrode and the fl uid. The electrode contains a gel that depletes 
over time, so the instrument must be readjusted periodically to 
maintain system accuracy. The need for recalibration varies with each 
application, but the life of the electrode is usually consistent.

• Keep a maintenance log to establish a depletion trend in new systems.
• The mV calibration is a two-point procedure. Signet offers pH buffer 

solutions prepared specifi cally for this purpose.
• pH buffer solutions can be used for calibrating more than one sensor 

within a day provided that the solutions are protected from debris and 
are not diluted by rinse water from the calibration procedure.

• Use clean water to rinse buffer solutions from the electrode.
• Dispose of all buffer solutions at the end of the day.
• If the pH sensor will not calibrate within acceptable limits, clean the 

electrode and recalibrate. If the calibration results remain outside of 
acceptable limits, the sensor is depleted and must be discarded.

• Follow the guidelines of local waste disposal regulations when 
discarding buffer solutions and spent electrodes.

Electrode slope is the ratio of mV to pH units.
At 25 °C the theoretical slope is 59.16 mV per pH.

Theoretical mV Values @ 25 °C
pH mV

2 +295.8 mV

3 +236.64 mV

4 +177.48 mV

5 +118.32 mV

6 +59.16 mV

7 0 mV

8 -59.16 mV

9 -118.32 mV

10 -177.48 mV

11 -236.64 mV

12 -295.8 mV

pH Calibration Procedure
1. Rinse the sensor off in the rinse water cup. Gently pat dry with a soft, dry cloth or tissue. Warning: Do not let the rinse 

water drip into the buffer solution; this will dilute the solution and may change the buffer values.
2. Place the pH sensor in the fi rst buffer solution (pH 7). Wait until the output from the sensor is stable on the instrument display.
3. Follow the instrument’s instructions regarding buffer recognition.
4. Rinse the sensor with water. Warning: Do not let the rinse water drip into the buffer solution; this will dilute the 

solution and may change the buffer values.
5. Dry the sensor gently by patting it with a dry, clean cloth or tissue.
6. Place the sensor in a cup containing the second buffer solution (pH 4 or pH 10). The second solution used will depend on 

the typical pH value of the application.
• If the process value is below pH 7, then use a pH 4 buffer solution.
• pH 10 buffer solution is used when the typical process value is above 7 pH; however, pH 4 buffer is suffi cient if pH 10 

buffer is not available.
7. Wait until the output from the sensor is stable.
8. Follow the instructions in the instrument manual regarding buffer recognition.
9. Rinse the sensor with water. Warning: Do not let the rinse water drip into the buffer solution; this will dilute the 

solution and may change the buffer values.
10. Dry the sensor gently by patting it with a dry, clean cloth or tissue.
11. If the calibration was successful, put the sensor back on-line. If it was not successful, clean the sensor and recalibrate. 

If the sensor cannot be calibrated, the electrode may need to be replaced.

  Calibration
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Sensor Removal

Figure 2

Figure 1

Under certain conditions, a dirty fl ow cell and fi lter can create a chlorine demand 
which could lower the chlorine concentration in the water fl owing past the 
chlorine sensor. It is recommended to clean the fi lter and fl ow cell on a regular 
basis. The frequency of necessary cleaning will depend on the application in 
which the system is being used and the level of accuracy required.

Step 1. Keep the system powered on.
Step 2. Disable the relays and any output loops.
Step 3. Turn off the water fl ow.
Step 4. Remove the sensors from the fl ow cell. NOTE: It is not 

necessary to remove the electronics from the sensor.
Step 5. Install the vinyl caps on to the sensor tips or place the tips of 

the removed sensors in a cup of sample water for temporary 
storage while cleaning the fl ow cell.

 Keep the sensor tips wet and the sensors energized.
Step 6. Remove the fl ow cell from the panel by removing the 

knurled nuts (Figure 1).
Step 7. Remove the remaining hardware from the fl ow cell.

(Figure 2).
NOTE: It is recommended that an anti-seizing compound appropriate for the 
application be used during the reassembling of the fl ow cell.

Maintenance - 463X Chlorine Analyzer Flow Cell

CAUTION: Over time, a sensor can get tight in the fl ow cell fi tting. When removing the sensor, avoid 
hitting the sensor electronics on the bottom of the wiring enclosure if the sensor suddenly releases. 
Take care not to damage the components.

While holding the fl ow cell, grasp the yellow electronics as a whole unit and 
carefully pull upwards, gently rocking back and forth if necessary. Once the 
sensor is loose, disengage the electronics, then remove the sensor.

TIP: A tool can be used to carefully pry the sensor electronics up and out if it is 
diffi cult to remove.

Cleaning

Service the fl ow cell on a clean, dirt free surface 
to avoid scratches or damage to the fl ow cell.

• Wash the surfaces with plain or soapy water only.
• Use gentle, liquid dishwashing soap if necessary.
• DO NOT USE commercial glass cleaning fl uids.
• Use a soft, lint-free cloth.

If your inlet pressure is less than 1 bar (15 psi), remove 
the fl ow regulator and quick disconnect inlet connector.

Remove fi lter 
screen to clean. 
If the fi lter is not 

desired, it may 
be removed from 

the system.

Flow Regulator

Servicing the Flow Regulator and Filter

WARNING: Do not disassemble the fl ow regulator. 
There are no user serviceable parts inside.

  Appendix
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1

2 3

6
5

4

Individual O-rings shown.
Butt all segment joints together in fi nal assembly.

New O-ring
cross section

Old fl attened O-ring
cross section

(Replace)

Fit fl ush with no gap
 Straight cut

Angle cut O-ring
Fit fl ush with no gap

Angle cut O-ring
Fit fl ush with no gap

Straight cut

Butt ends together

Fit all O-ring joints so there is no gap in fi nal assembly.

 O-Ring Installation

• The sealing of the fl ow cell is accomplished by four cut O-ring segments 
and two round O-rings sealing the fl ow regulator. Refer to the illustration 
below for special O-ring fi tting instructions. Butt all O-ring joints together 
so there is no gap.

• Remove the O-rings during fl ow cell disassembly. Both the O-rings and all 
sealing grooves should be examined for cleanliness.

• Wipe all surfaces carefully with a soft, lint-free cloth to ensure good sealing.

• The cross section of the O-rings should be round and smooth. If they are 
fl attened, their ability to seal is reduced.

• Do not use liquid or paste sealant.

Do not scratch the sealing surfaces of the fl ow cell block. 
Scratches to the sealing surfaces can cause irreparable leaks.

CAUTION! The 3-4630.390 (159 001 688) O-ring kit 
comes complete with two O-rings (5 and 6) and a 
single cord of material that must be cut and fi tted 
into the O-ring groove of the fl ow cell (1 and 4).

  Appendix
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WARNING! Do not over tighten fl ow cell bolts. Maximum torque is 8.1 Nm (72 Lb-In).
Over tightening the bolts can damage the fl ow cell.
Do not over-tighten the bolts in an attempt to stop a leak.

Tighten the nut just enough to hold 
the block together and keep the 
O-rings in place.

6

Tighten the bolts in three passes to 
specifi cation.8

Install the nut and washers.5

Install the remaining bolts, washers 
and nuts.7

Install the assembled pressure 
regulator and the two round 
O-rings into the fl ow cell.

1

Install the four O-ring segments.2

Insert the center bolt into the block.3

4 Align and place the back block onto 
the fl ow cell. Check to be sure that 
the O-rings are seated correctly.

9 Install the fl ow cell on the panel.
Screw on the thumb nuts fi nger tight.
DO NOT use tools on the thumb nuts.

NOTE: It is recommended that an anti-seizing compound appropriate for 
the application be used during the reassembling of the fl ow cell.

Flow Cell Assembly

12

3

6

5

Torque 
8.1 Nm 

(72 Lb-In)
MAX!

4

Tighten bolts in 3 passes

  Appendix
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It is required to calibrate the sensor after servicing the 
membrane and electrolyte. See Page 24.

Verifying the sensors accuracy using the DPD method 
should be performed to determine if the sensor requires 
maintenance.
1. Inspect the membrane for dirt or damage. Replace the 

membrane if its torn or if the gold-plated cathode 
is visible. 

2. If the membrane is dirty clean the membrane by soaking it 
in 1 - 5% HCL and gently washed with a stream of DI water. 
(do not use any mechanical device on the membrane)

• If a fresh water rinse does not clean the membrane, 
it will need to be replaced.

• Keep spare membrane caps available. 
Membrane caps carry no warranty.

Refi ll Procedure:
When adding electrolyte, be prepared for an accidental spill.
Working near a sink is recommended.

1. Remove the membrane cap from the front of the sensor.
2. Turn the sensor upside down and shake the sensor 

vigorously to remove the internal electrolyte.
3. Fill supplied syringe with electrolyte solution.

Additional caution should be taken when handling Chlorine 
Dioxide electrolyte solution.

4. Place the electrode on a level surface.
5. Insert syringe needle fully into one of the eight electrode 

holes while injecting with electrolyte solution. Slowly 
injecting the electrolyte solution into the sensor to avoid 
introducing air bubbles. The electrode holds 
approximately 14 milliliters of solution. Slowly fi ll until 
solution begins to fl ow out of holes. Do not allow the 
solution to run down the electrode and wet the electrical 
contacts in the DryLoc connector.

6. Slowly screw on the membrane cap fi nger tight. 
Do not use tools. 
To avoid damage and contamination, do not touch 
the white membrane surface on the membrane cap.

Diluted HCl can irritate the eyes and skin, 
use proper safety equipment.  
Do not use surface tension reducing chemicals, 
detergents or solvents on the membrane.

Avoid skin or eye contact with electrolyte 
solution. Wear rubber gloves and goggles.
* Material Safety Data Sheets (MSDS) are   
 available online at www.gfsignet.com.

Maintenance - 2630 Free Chlorine Electrode
Maintenance - 2632 Chlorine Dioxide Electrode

Storage
If the sensor or panel assembly is to be removed from 
service for a period of time the sensor must be properly 
prepared for storage and may need to be recommissioned.

Store electrode between  -10 ºC to 60 ºC 
(-4 ºF to 140 ºF) at a relative humidity that 
does not exceed 95%. 

The primary concerns when storing the 
electrode is membrane dehydration and 
freezing in extremely cold environments.

DO NOT
FREEZE

1 week or less:
• Close the drain valve, then close the inlet valve of the 

fl ow cell, to maintain water inside the fl ow cell to keep 
the membrane wet.

• If draining the fl ow cell is required, remove the sensor 
from the cell and the 2650 electronics and store in the 
shipping bottle with tap water added.

Continue to Page 37 for additional storage periods

Storage Periods:

CAUTION: 
DO NOT touch the gold-plated tip 
or the membrane of the sensor.

  Appendix
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Storage periods greater than 2 months:
• If the sensor has been in storage for a long period of 

time, or used in a chlorine free environment, the sensor 
may develop a low slope (output), which may cause the 
sensor to have a slow response time.

• In this case, the sensor must be reconditioned.

Required to recondition a sensor:
• DI Water
• Beaker (any size available)
• Polishing Sheets (Included in sensor maintenance kit)
• Free Chlorine: Chlorine Bleach (13% concentration)
• Chlorine Dioxide: Aqueous Chlorine Dioxide solution

Reconditioning Procedure:
1. Remove the sensor from the 2750-7 electronics.
2. Remove the membrane cap.
3. Place the sensor on a fi rm fl at surface with the 

gold-plated cathode pointing upward.
4. Apply a small amount of water to the Blue (Coarse) 

polishing paper (dull side).
5. Polish the gold-plated electrode by moving the paper in 

a circular pattern for 10 seconds. DO NOT go back and 
forth in a single direction. See Figure 1.

6. Rinse the sensor tip with DI water.
7. Apply a small amount of DI water to the White (Fine) 

polishing paper (dull side) and polish the gold-plated 
electrode by moving the paper in a circular pattern 
40-60 seconds.  DO NOT go back and forth in a single 
direction. See Figure 1.

8. Rinse the sensor tip with DI water.
9. Top off the sensor with electrolyte and inspect 

membrane for dirt or damage. Replace if necessary.
10. Insert the sensor into the 2650 electronics and 

apply power.
11. Fill beaker with a 12 mm (½ inch) of the appropriate solution.
12. Position or suspend the sensor 0.2 mm to 12 mm 

(¼ in. to ½ in.) above the appropriate solution. 
See Figure 2. DO NOT SUBMERGE THE SENSOR.

13. Apply power to the system.
14. Monitor the nA of the sensor (press the down arrow once 

on the 8630 transmitter). The nA reading should start to 
rise. Response time and nA reading will depend upon 
the temperature of the appropriate solution.

15. Once the sensor's nA reading reaches approximately 
300-360 nA allow the sensor to remain in the beaker, 
suspended over the appropriate solution, for an 
additional 20 minutes.

 • If sensor does not recover quickly, cover the 
 beaker to avoid air contamination.

 • Contact the factory for assistance (www.gfsignet.com).
16. After 20 minutes, remove the sensor and install it into 

the fl ow cell and restore fl ow to the system.
17. Calibrate the sensor after the system has become stable.

CAUTION!
 Bleach and Chlorine Dioxide solutions are very 
corrosive and may release dangerous gases if it 
comes in contact with acids.

• Wear proper protective clothing (gloves and eye protection)
• Avoid contact with skin and eyes
• Observe all warnings on safety data sheets
• Avoid spilling bleach and possible contact with acids

Figure 2

Figure 1

Curved Surface

Storage Periods Greater than 1 week, 
but less than 2 months:

Recommissioning Procedure:
1. Fill the sensor with the electrolyte as outlined in 

Maintenance, Page 36, and install the membrane cap.
2. The sensor will have to be polarized in the fl ow cell with 

fl owing Chlorinated water before being used. 
Note: This may take 30 to 120 minutes before calibration 
can be performed.

3. If the sensor does not recover after recommission, follow 
steps 1-10 outlined under Storage periods greater than 
2 months.

4. If the sensor still fails to work properly, continue with 
steps 11-17.

  Appendix
Storage of sensor
• Remove the membrane cap and internal electrolyte 

solution.
• Rinse the sensor internal chamber with DI water or cold 

tap water; drain and allow to dry.
• Place the membrane cap back onto the sensor. INSTALL 

LOOSE, DO NOT COMPLETELY TIGHTEN THE CAP. 
WHEN STORED DRY, THE MEMBRANE CAP MUST BE 
STORED RELAXED AND UNSTRESSED.

• Store sensor DRY in the shipping bottle, 
DO NOT ADD WATER.



38 463X Chlorine Systems Manual

Electrode Care and Application

pH electrodes are similar to batteries; they age with time and usage. The following information will help maximize electrode life.

General Tips:
• To ensure uninterrupted operation of critical pH systems, replacement electrodes should be available.
• Store boxed electrodes fl at or upright (electrode tip down) to maximize hydration of the glass surface.
• Keep the glass surface wet at all times.
• Soak the sensor tip in pH 4.0 buffer during system maintenance intervals.
• If the sensor dehydrates, soak the sensor tip in pH 4 buffer for 24 to 48 hours, then visually inspect the electrode for surface 

cracks, swelling, or discoloration.
• It may not be possible to restore severely dehydrated electrodes to normal operation.
• High temperatures, strong acids or caustics will increase electrochemical reactions and speed electrode aging.
• Coatings (e.g. grease) on the glass or junction surfaces cause extended response time and inaccurate measurement.
• Never store the electrode tip in deionized (DI) water. Use pH 4 buffer solution to keep the glass wet when out of the process.
• Never store the electrode at temperatures below 0 °C (32 °F) or allow it to dehydrate.
• Never scrape or sand the glass electrode surface.
• Treat glass electrode surfaces with care to prevent accidental breakage.

Maintenance - 2724 DryLoc® pH Electrode

Problem Suggested Solution

Hard Coatings

Use a dilute acid solution (HCl solution of 5% or less). If the electrode has been used in applications 
with a pH value higher than 7 pH, soak the electrode for 2 to 5 minutes.

Use a dilute alkaline solution (NaOH solution at 5% or less) if the electrode has been used in 
applications with pH values less than 7 pH, soak the electrode for 2 to 5 minutes.

Alternating immersion in acidic and alkaline solutions may be necessary for thorough cleaning.

Soft Coatings Spray or vigorously stir the electrode with a mild detergent, such as dishwashing liquid. Chlorine 
bleach can also be used.

Oily or Organic Coatings Spray or vigorously stir the electrode with a mild detergent or an appropriate solvent that will not 
attack the materials of construction (isopropyl alcohol or similar).

After Cleaning
Always rinse the electrode with water after cleaning.

Soak the electrode in a pH 4 buffer (with KCl if available) for at least 10 minutes after cleaning.

Cleaning
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The troubleshooting table below outlines possible causes and remedies related to the fl ow cell panel system. 
Refer to the respective transmitter and sensor manuals for specifi c component troubleshooting.

Problem Possible Cause Remedies

No water fl ow

Inlet pressure below 1 bar (15 psi) Check source pressure. Remove regulator if pressure is
< 1 bar/15 psi

Damaged fl ow regulator Replace fl ow regulator

Clogged fi lter Clean fi lter or remove pressure regulator if inlet pressure is 
below 1 bar (15 psi)

Low water fl ow

Clogged fi lter Clean fi lter

Insuffi cient inlet pressure Increase inlet pressure to specifi cation or remove fl ow 
regulator

Damaged fl ow regulator Inspect or replace

Excessive fl ow
Excessive pressure over 8 bar (120 psi) Ensure inlet pressure does not exceed 8 bar (120 psi)

Damaged fl ow regulator Replace fl ow regulator

Flow cell leaks

Incorrect assembly Inspect, clean, and reassemble

Loose bolts Tighten bolts (8.1 Nm, 72 Lb-In Max)

Defective or missing O-rings Replace O-rings

Damaged sealing surfaces Replace fl ow cell

Leaks around sensor
Damaged sensor O-ring Inspect or replace O-ring

Damaged fl ow cell Inspect fl ow cell

Water leaks out of top vent hole

Drain valve closed or plugged Inspect

Hose connections are backwards Connect water source correctly

Outlet drain not below fl ow cell Route drain line below fl ow cell and vented to atmosphere

Algae growth in fl ow cell
Low chlorine concentration in water

Locate fl ow cell away from light
Exposure to light

Excessive small bubbles in fl ow 
cell accumulating on sensors

Water source contains bubbles
Check water sourceWater source is saturated with 

dissolved gasses

Transmitter does not turn on

No power or external circuit breaker is  
switched off Inspect power and wiring connections

Loose or incorrect wire connections Check connections
Open loop wiring or missing jumper 
wire on terminal 1 (Loop 1) on the 
wiring enclosure terminal block

Replace jumper wire to terminal 1 or connect a loop device 
if the jumper wire to terminal 1 is removed

Chlorine reading too high Breached membrane Replace membrane and fi ll solution

Chlorine reading too low

Electrode needs to be repolished Polish gold-plated electrode

Not enough electrolyte Check electrolyte level

Low fl ow rate Check source pressure

Filter clogged Clean the fi lter

Sensor conditioning not long enough Allow the sensor to condition for 4 hours
(See 2630 or 2632 sensor manual for details)

Sensor output drifts

Electrode needs to be repolished Polish gold-plated electrode

Not enough electrolyte Check electrolyte level

Variable fl ow rate Check fl ow rate

Clogged fi lter Clean the fi lter

Contaminated fi ll solution Change electrolyte fi ll solution

Chlorine Electrode Troubleshooting (see 2630-2 or 2632-1 electrode manual: 3-2630.090)

Transmitter Troubleshooting (see 8630-3 transmitter manual: 3-8630.090-3)

pH Electrode Troubleshooting (see 2724 electrode manual: 3-2724.090)

Troubleshooting - 463X Chlorine Analyzer
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Several factors can cause irregular or incorrect readings. The fi rst thing to check is to verify that the transmitter and 
sensors have been installed correctly. The list below outlines possible causes and remedies.

Problem Possible Cause Remedies

Transmitter does not turn on.

Incorrect wiring.
No or low voltage supplied to transmitter.
Blown fuse.
Bad wire connections or splices.

Check wiring, power supply and wiring 
connections.

Display screen is too dark or too dim. Contrast set incorrectly or ambient temperature 
is too high. Adjust contrast in Options Menu.

LCD backlight, relays and sensors do not 
work. No power supplied to terminals 1 and 2. Transmitter requires power to terminals 

1, 2, 3 and 4.

Incorrect temperature reading. Faulty chlorine sensor.
Bad sensor connection. Check connections or replace sensor.

Display or Current output is erratic.
Electrical noise interfering with the 
measurement.
Sensor malfunction.

Ensure system is properly grounded.
See Sensor Troubleshooting.

Output is not zero when electrode is 
placed in non-chlorinated water.

Electrode not properly conditioned.
Noise interfering with the measurement.
Calibration incorrect.

Condition new sensor for 4 hours. Cap 
replacement or electrolyte refi ll: 2 hours.
Properly ground system.
Replace sensor.

4 to 20 mA output is incorrect. 4 to 20 mA is not scaled same as Loop device.
Loop device is not scaled same as sensor. Re-span loop device to match sensor.

Chlorine Sensor Troubleshooting (see 2630 sensor manual)

Incorrect readings

Sensor conditioning time too short. Run for 4 hours before calibrating.

Membrane cap damaged or contaminated. Clean or replace cap.

Interference from water contaminants. See Specifi cations data. 

Low fl ow rate. Check fl ow.

Air bubbles on membrane. Install fl ow cell vertically with upwards 
fl ow.

pH outside working range 
(See Specifi cations data). Check pH.

Low or no electrolyte in sensor. Fill sensor with electrolyte.

Membrane cap loose. Inspect/tighten (do not use tools).

Only combined chlorine present when 
measuring free chlorine. Validate with DPD test.

Sensor not making good contact with 
electronics. Inspect and reconnect.

Defective sensor. Replace.

No pH compensation being used. Manually enter pH value in Options or 
calibrate pH sensor.

Cl sensor not calibrated. Calibrate Cl sensor.

Troubleshooting - 8630 Chlorine Transmitter
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The 8630 error warnings are self-explanatory.  An error message can appear under the following circumstances:

Error Messages Problem Possible Cause Remedies

Sens Data Error Cl sensor data memory error. Cl sensor is not connected.
Damaged sensor.

Check Cl sensor wiring and 
connection.
Perform "Find New Sensor" or 
recycle power afterward.

 CHK Cl PREAMP Cl preamp is not detected.
Cl preamp is not connected.
Wrong wiring.
Damaged preamp.

Check preamp and transmitter 
wiring.
Perform "Find New Sensor" or 
recycle power afterward.

 CHK pH PREAMP pH preamp is not detected.
pH preamp is not connected.
Wrong wiring.
Damaged preamp.

Check preamp and transmitter 
wiring.
Perform "Find New Sensor" or 
recycle power afterward.

 CHK Cl SENSOR Cl sensor is not detected. Cl sensor not connected.
Damaged sensor. Check sensor connection.

 CHK pH SENSOR pH sensor is not detected. pH sensor is not connected.
Damaged sensor. Check sensor connection.

  Out Of Range
  CHECK SENSOR pH calibration error. pH values are out of range. Enter proper values during 

calibration.

Standard Too Close
 To Slope!

pH standard calibration point 
is too close to slope point.

Wrong data is entered. pH 
buffer solution used has 
value too close to standard 
point.

Re-enter correct data.
Use proper buffer solution at 
least 2 pH units apart from 
slope buffer solution.

Slope Too Close
 To Standard!

pH slope calibration point is 
too close to standard point.

Wrong data is entered. pH 
buffer solution used has 
value too close to standard 
point.

Re-enter correct data.
Use proper buffer solution at 
least 2 pH units apart from 
standard buffer solution.

Signal Too Close 
To Other Cal Pt

The signal level of Cl for 
In-process calibration is too 
close to the Zero Cal Point. 

The Cl solution used for
In-process calibration is too 
close to Zero Cal. These two 
points must be 1 nA apart.

Use proper solution at least
1 nA apart.

Cl Value Must Be 
   > = 0.2 ppm

The Cl value entered during 
In-process calibration is too 
small.

Wrong data is entered. The 
value entered must be at 
least 0.2 ppm (mg/l).

Re-enter correct value.

Signal Too High
Must Be =< 10 nA

The signal level during Zero 
calibration is too high. Signal 
must be equal or less than
10 nA.

The sensor is not stabilized. 
The solution used has too 
much chlorine.

Wait for sensor stabilization.
Check solution to ensure that 
the chlorine level is close to
zero ppm (mg/l).

pH Too High
Must be =< 9 pH value is too high.

During In-Process calibration 
the pH value is too high and 
must be less than or equal
to 9.

Check pH.

pH Too Low
Must be >= 4 pH value is too low.

During In-process calibration 
the pH value is too low and 
must be greater than or 
equal to 4.

Check pH.

8630 Transmitter Error Messages

• User input value is out of range
• Poor electrical connection
• Sensor is not connected or detected

• Temperature error
• Incorrect sensor type chosen in the Options Menu
• Two calibration points are too close together when calibrating pH or chlorine.
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 Transmitter Error Messages - continued

NOTE:  Whenever a new type of Cl Sensor is connected to the preamp, a power recycling is required. Another option is to 
perform a "Find New Sensor" under the Option Menu.

FCl= – – – – – –
CHK pH SENSOR pH sensor is not detected.

pH sensor is not connected.
Wrong wiring.
Damaged pH sensor.

Check pH sensor connections 
or change pH input to Manual in 
Options Menu.

FCl= – – – – – –
CHK pH PREAMP pH preamp is not detected.

pH preamp is not connected.
Wrong wiring.
Damaged preamp.

Check pH preamp wiring.
Perform a "Find New Sensor" or 
recycle power afterward.

FCl= WRONG SENSOR Wrong sensor is detected.

Different type of sensor is 
connected.
Wrong sensor type is selected 
under Option Menu.

Use correct sensor type.
Perform a "Find New Sensor" or 
recycle power afterward.
Select correct sensor type under 
Option Menu.
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Problem Possible Causes Remedies

Sensor cannot be calibrated.
Output is lower than DPD test.

Sensor conditioning time too short Condition for 4 hours minimum prior to initial 
calibration

Chlorine content too low DPD value must be greater than 0.2 ppm to 
calibrate

Low fl ow rate Check to make sure fl ow rate is suffi cient

Air bubbles on electrode membrane Inspect visually. Tap to remove bubbles. 
Mount at an angle

Low or no electrolyte in electrode Fill electrode with electrolyte
Organic chlorination agents present in water See Specifi cations data
Surfactants in water Remove surfactants and replace cap
Membrane cap coated Clean or replace membrane cap
Membrane cap loose Tighten or replace membrane cap
pH outside working range. See Specifi cations data

Sensor output very low

Electrode needs to be repolished Polish gold-plated electrode
Not enough electrolyte Check electrolyte level

Sensor conditioning time too short Condition for 4 hours minimum prior to initial 
calibration

Chlorine content too low Add chlorine to validate

Only bound chlorine present. No free chlorine Check for chloramine with appropriate DPD 
test

Electrode not making good contact with 
electronics Inspect and reconnect

Unstable output from sensor

Electrode needs to be repolished Polish gold-plated electrode
Not enough electrolyte Check electrolyte level

Air bubbles on electrode membrane Inspect visually. Tap to remove bubbles. 
Mount at an angle

Membrane damaged Replace membrane. Condition sensor for at 
least 2 hours and recalibrate.

Electrode not making good contact with 
electronics Inspect and reconnect

Non-sensor problem

Check 3-2650 Electronics connection 
to electrode (see 3-2650 manual for 
instructions). Make sure connections are dry. 
Check instrument hookup

Transmitter error messages related to calibration are detailed in the Signet 8630 Chlorine Transmitter operation manual.

Problem Possible Cause Remedies

After completing calibration procedure, 
the output values are inaccurate.

Insuffi cient time allowed for electrode 
stabilization during calibration.

Recalibrate, verify that test solutions are 
at room temperature and wait at least 30 
seconds after placing electrode in solution.

Transmitter Troubleshooting (see 8630-3 transmitter manual: 3-8630.090-3)
pH Electrode Troubleshooting (see 2724 electrode manual: 3-2724.090)

Troubleshooting - 2630 Free Chlorine Electrode
Troubleshooting - 2632 Chlorine Dioxide Electrode

Troubleshooting - 2750-7 pH Electronics
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Input Specifi cations
• One Digital (S3L) input from Free Chlorine or
 Chlorine Dioxide sensor
• One Digital (S3L) input from pH sensor

Output Specifi cations:
• Current Loop (2 loops provided)
• 4 to 20 mA, isolated, adjustable span, reversible with
 minimum and maximum endpoint adjustment.
• Ability to use chlorine or temperature as input
• Update Rate: 300 ms
• Max Loop impedance:   50 Ω max. @ 12 V
   325 Ω max. @ 18 V
   600 Ω max. @ 24 V
Relay Outputs:
• 2 mechanical SPDT contacts with adjustable hysteresis
 and programmable High, Low, Off, Pulse or Window range.
• May be disabled if not used
• Max. voltage rating: 5 A @ 30 VDC
   5 A @ 250 VAC, resistive load
• Time delay:  Programmable from 0 to 6400 s

Environmental Requirements
• Operating Temperature: -25 °C to 120 °C (-13 °F to 248 °F)

 (transmitter only)
• Storage Temperature: -15 °C to 80 °C (5 °F to 176 °F)
• Relative Humidity: 0 to 95%, non-condensing
• Maximum Altitude: 2000 m (6562 ft)
• Enclosure:  NEMA 4X

Standards and Approvals
 • CE, UL, CUL, WEEE
 • RoHS Compliant
 • Manufactured under ISO 9001 for Quality,
  ISO 14001 for Environmental Management and 
  OHSAS 18001 for occupational health and safety.
  China RoHS (Go to www.gfsignet.com for details)
  Declaration of Conformity according to FCC Part 15
  This device complies with Part 15 of the FCC rules.
  Operation is subject to the following two conditions:
  (1) This device may not cause harmful interference, and,
  (2) This device must accept any interference received,
  including interference that may cause undesired operation.

General
Compatibility:
• Sensors: 3-2630-1 Free Chlorine Sensor 0.02 to 2 ppm
  3-2630-2 Free Chlorine Sensor 0.05 to 5 ppm
  3-2630-3 Free Chlorine Sensor 0.01 to 20 ppm
  3-2632-1 ClO2 Electrode, 0.02-2 ppm
  3-2724-00 Flat pH Electrode, See FCL and 

CL02 system pH specifi cation 
• Electronics: 3-2650-7 Amperometric Electronics
  3-2750-7 pH Sensor Electronics

Materials:
• Case: PBT
• Panel gasket: Neoprene
• Window: Polyurethane-coated polycarbonate
• Keypad: Silicone rubber
• Display: Backlit alphanumeric 2 x 16 dot matrix
 Update rate: 1 second
 Contrast: User selected, 5 levels
• Keypad: Silicone rubber

Performance
System Operational Ranges/Limits:
• 3-2630-1: Free Cl: 0.02 to 2 ppm, pH: 5 to 8.5
• 3-2630-2: Free Cl: 0.05 to 5 ppm, pH: 5 to 8.5
• 3-2630-3:  Free Cl: 0.1 to 20 ppm, pH: 5 to 8.5
• 3-2632-1: ClO2: 0.2 to 2 ppm, pH: 4 to 11
• 3-2724-00: pH: 0 to 14 (8.5 when used with the 4630)
Cl Temp. Range: 0 °C to 45 °C (32 °F to 113 °F)

Max. Cable Length:
• Digital (S3L): 30 m (100 ft) maximum
• 4 to 20 mA: 305 m (1000 ft) maximum

Electrical
Input Power: 12 to 24 VDC ±10% regulated,

250 mA max current
Sensor Power: 5 VDC ±1% @ 25 ºC, regulated

(provided by 8630)

8630 Chlorine Transmitter

  Specifi cations
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General
Compatibility:
• Sensors: All Signet Amperometric DryLoc Sensors
• Instruments: Signet 3-8630-3P Chlorine Transmitter

Mounting: DryLoc connection
Materials: PBT
Cable: 4.6 m (15 ft) 3 conductor shielded, 22 AWG
• Max. Length: 30 m (100 ft)

Performance
• Accuracy < 5 nA or 1% of reading, whichever is 

greater @ 25 °C over full input range
• Temperature: ± 1.0 °C (PT1000) over full operation range 

(when calibrated at ambient temperature)
• Update Rate: 500 ms
• Range: ± 450 nA
• Resolution: 0.1 nA

Electrical
Input Specifi cations:
• Sensor: Raw signal
• Temperature: PT1000 RTD

Output Specifi cations:
• Digital (S3L):  Serial ASCII, TTL level 9600 bps

Power Supply Input:
• Digital (S3L): 5 to 6.5 V ± 10%, 3 mA max

Environmental
• Storage Temp.: -20 °C to 50 °C (-4 °F to 120 °F)
• Operating Temp.: 0 °C to 85 °C (32 °F to 185 °F)

(electronics only)
• Relative Humidity: 0 to 95%, non-condensing

(no electrode connected)
• Enclosure: NEMA 4X/IP65 with electrode installed
• Shipping Weight: 0.64 kg (1.41 lb)

Standards and Approvals
 • CE, WEEE
 • RoHS Compliant
 • Manufactured under ISO 9001 for Quality,
  ISO 14001 for Environmental Management and 
  OHSAS 18001 for occupational health and safety.
  China RoHS (Go to www.gfsignet.com for details)
  Declaration of Conformity according to FCC Part 15
  This device complies with Part 15 of the FCC rules.
  Operation is subject to the following two conditions:
  (1) This device may not cause harmful interference, and,
  (2) This device must accept any interference received,
  including interference that may cause undesired operation.

2650 DryLoc Amperometric Electronics 2750-7 pH Electronics
General
Compatibility:
• Electrode: Signet 2724-00 Flat pH electrode
• Instrument: Signet 8630-3P Chlorine Transmitter

Mounting: DryLoc connection
Materials: PBT
Cable: 4.6 m (15 ft) 3 conductor shielded, 22 AWG

Performance
• Accuracy: ± 0.03 pH @ 25 °C
• Resolution: 0.02 pH
• Response Time (includes electrode response):

< 6 s for 95% of change
• Range: 0.00 to 14.00 pH (8.2 when used with 

the 4630)
• Resolution: 0.02 pH

Electrical
Input Specifi cations:
• Input Impedance: >1011 Ω
• Temperature Drift: ± 0.002 pH per ºC
• Input Resolution: 0.02 pH, 0.3 ºC

Output Specifi cations:
• Digital (S3L): Serial ASCII, TTL level 9600 bps

Environmental
• Storage Temp.: -20 °C to 50 °C (-4 °F to 120 °F)
• Operating Temp. (Electronics Only):
   0 °C to 85 °C (32 °F to 185 °F)
• Relative Humidity: 0 to 95%, non-condensing
• Enclosure: NEMA 4X/IP65 with electrode installed
• Shipping Weight: 0.64 kg (1.41 lb)

Standards and Approvals
 • CE, WEEE
 • RoHS Compliant
 • Manufactured under ISO 9001 for Quality,
  ISO 14001 for Environmental Management and 
  OHSAS 18001 for occupational health and safety.
  China RoHS (Go to www.gfsignet.com for details)
  Declaration of Conformity according to FCC Part 15
  This device complies with Part 15 of the FCC rules.
  Operation is subject to the following two conditions:
  (1) This device may not cause harmful interference, and,
  (2) This device must accept any interference received,
  including interference that may cause undesired operation.

  Specifi cations
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2630-X Amperometric Free Chlorine Electrode
2632 Amperometric Chlorine Dioxide Electrode

Operational Ranges and Limits
 Free Chlorine .......................  3-2630-1: 0.02 to 2 ppm (mg/L)

3-2630-2: 0.05 to 5 ppm (mg/L)
3-2630-3: 0.1 to 20 ppm (mg/L)

 Free Chlorine pH .................5.5 to 8.5 pH
 Chlorine Dioxide ..................  3-2632-1: 0.02 to 2 ppm (mg/L)
 Chlorine Dioxide pH .............4.0 to 11.0 pH

Temperature .............................0 °C to 45 °C (32 °F to 113 °F)

Maximum Pressure
 Membrane ............................0.48 bar @ 25 °C (7 psi @ 77 °F)

Flow Velocity Across Membrane Surfac:
 Minimum ..............................15 cm/s (0.49 ft/s)
 Maximum .............................30 cm/s (0.98 ft/s)

Cross Sensitivity
 Free Chlorine .......................ClO2, ozone, bromine
 Chlorine Dioxide ..................FCl, ozone

Chemical Compatibility ............< 50% ethanol/water < 50% 
glycerol/water

Environmental
Temperature
 Operating .............................0 ºC to 45 ºC (32 ºF to 113 ºF)
 Storage (dry) ........................-10 ºC to 60 ºC (-4 ºF to 140 ºF)

Relative Humidity .....................0 to 95% indoor/outdoor non-
condensing to rated ambient

Shipping Weight.......................0.14 kg (0.30 lb)

Standards and Approvals
 CE, WEEE
 RoHS Compliant
 Manufactured under ISO 9001 for Quality,
 China RoHS (Go to www.gfsignet.com for details)
 Declaration of Conformity according to FCC Part 15
 This device complies with Part 15 of the FCC rules.
 Operation is subject to the following two conditions:
 (1) This device may not cause harmful interference, and,
 (2) This device must accept any interference received,
 including interference that may cause undesired operation.

  Specifi cations

General
Compatibility
 Flow Cells .............................  Signet 3-4630.392
 Electronics ............................Signet 2650 Amperometric 

Electronics

Mounting ..................................Signet DryLoc connection

Materials
 Housing ................................CPVC
 Membrane
    Free Chlorine ....................  PTFE
    Chlorine Dioxide ...............PTFE
 O-ring ...................................FKM
 Electrode ..............................Gold-plated (working)

Silver halide (counter-reference)
Wetted Materials ......................  PVC, PTFE, FKM, Nylon,

Silicone

Performance
Electrode
 Repeatability ........................  ± 0.08 ppm (mg/L) or 3% of 

selected range whichever is less
Slope
 Free Chlorine .......................15 to 85 nA/ppm (mg/L) @ 25 ºC 
 Chlorine Dioxide ..................40 to 200 nA/ppm (mg/L) @ 17 ºC
 Response time, T90 ............< 2 minutes

Sensor Conditioning
 4 hours max. before calibration (new/fi rst time start)
 2 hours max. (subsequent start-ups)

System (including electronics and instrument)
 Accuracy ..............................< ±3% of electrode signal after 

calibration
 Resolution ............................≤ 0.5% of electrode range
Temp. Element .........................PT1000, Class B with 

measurement range of -50 ºC to 
150 ºC (-58 ºF to 302 ºF)
(measurement only, not operating 
specifi cation)



47463X Chlorine Systems Manual

General
Compatibility: ..................... Signet 2750 pH/ORP Sensor 

electronics

Process Connection ........... ¾ in. NPT or ISO 7/1 R¾ threads 
or Signet fl ow fi ttings

Wetted Materials ................ PPS, glass, UHMW PE, FKM

Performance
 Effi ciency ........................ >97% @ 25 °C (77 °F)

Effi ciency indicates the "wellness" 
of a new electrode. Effi ciency 
is measured by comparing the 
actual slope 
(mV/pH) at 25 °C to the 
theoretical output of 59.16 
mV/pH. An effi ciency of 97% 
to 100% is equivalent to a slope 
of 57.39 to 59.16 mV/pH.

 Range ............................. Free Chlorine 5.5 to 8.5 pH
Chlorine dioxide 4.0 to 11 pH

Environmental
Pressure
 Operating ........................  -10 ºC to 65 °C (14 °F to 149°F),

0 to 6.9 bar (0 to 100 psi)
 65 °C to 85 °C (149 °F to 185°F), 
Linearity derated 6.9 to 4.0 bar 
(100 to 58 psi)

Temperature
 Storage ........................... 0 °C to 50 °C (32 °F to 120 °F).

CAUTION: The electrode glass 
will be shattered if shipped or 
stored at temperatures below 
0 °C (32 °F). 
The performance life of the 
electrode will be shortened if 
stored at temperatures above 
50 °C (120 °F).

 Operating ........................ -10 ºC to 85 ºC (14 ºF to 185 ºF)

Rel. Humidity ...................... 0 to 95% indoor/outdoor non-
condensing to rated ambient

Shipping Weight ................. 0.25 kg (0.55 lb)

Standards and Approvals
 WEEE
 RoHS Compliant
 Manufactured under ISO 9001 for Quality, ISO 14001 for
 Environmental Management and OHSAS 18001 for
 occupational health and safety.
 China RoHS (Go to www.gfsignet.com for details)

2724 DryLoc pH Electrode

  Specifi cations
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Accessories and Replacement Parts
3-4630.390 159 001 688 Rebuild kit, O-rings, boots, screws, 1 fi lter screen

3-4630.391 159 001 689 Pressure regulator with 1 spare fi lter screen

3-4630.392 159 001 690 Acrylic fl ow cell complete with all components and connections

3-4630.393 159 310 162 Flow Switch Kit, PP

7300-0024 159 001 693 24 VDC Power Supply

3-2630.391 159 001 674 Free Chlorine electrolyte, 30 mL (2)

3-2632.391 159 310 160 Chlorine Dioxide electrolyte, 30 mL (2)

3-2630.394 159 310 164 Free Chlorine and Chlorine Dioxide Replacement PTFE membrane (1) 

3-2630.398 159 310 166 Free Chlorine Sensor maintenance kit - (2) electrolyte, (2) PTFE membranes, (2) Silicone Bands, and 
Polishing Paper

3-2632.398 159 310 165 Chlorine Dioxide maintenance kit - (2) electrolyte, (2) PTFE membranes, (2) Silicone Bands, and 
Polishing Paper

1220-0021 159 801 182 O-ring FKM

3-0700.390 198 864 403 pH Buffer Kit (1 each 4, 7, 10 pH buffer in powder form, makes 50 mL of each)

3822-7004 159 001 581 pH 4.01 buffer solution, 1 pint (473 mL) bottle

3822-7007 159 001 582 pH 7.00 buffer solution, 1 pint (473 mL) bottle

3822-7010 159 001 583 pH 10.00 buffer solution, 1 pint (473 mL) bottle

3-2700.395 159 001 605 Calibration kit: included 3 polypropylene cups, box used as cup stand, 1 pint pH 4.01, 1 pint pH 7.00

3-2759 159 000 762 pH/ORP System Tester (adapter cable sold separately)

3-2759.391 159 000 764 2759 DryLoc Adapter Cable (for use with 2750 and 2760)

  Ordering Information

463X Chlorine Analyzer
Mfr. Part No. Code Description
3-4630-10 159 001 748 Chlorine panel, transmitter, free chlorine sensor (0.02 to 2 ppm), w/ sensor electronics, no pH sensor

3-4630-11 159 001 749 Chlorine panel, transmitter, free chlorine sensor (0.02 to 2 ppm) w/ sensor electronics, pH sensor w/ electronics

3-4630-20 159 001 691 Chlorine panel, transmitter, free chlorine sensor (0.05 to 5 ppm) w/ sensor electronics, no pH sensor

3-4630-21 159 001 692 Chlorine panel, transmitter, free chlorine sensor (0.05 to 5 ppm) w/ sensor electronics, pH sensor w/ electronics

3-4630-30 159 001 750 Chlorine panel, transmitter, free chlorine sensor (0.01 to 20 ppm), w/ sensor electronics, no pH sensor

3-4630-31 159 001 751 Chlorine panel, transmitter, free chlorine sensor (0.01 to 20 ppm) w/ sensor electronics, pH sensor w/ electronics

3-4632-10 159 001 768 Chlorine panel, transmitter, chlorine dioxide sensor (0.02 to 2 ppm), with sensor electronics, no pH sensor

3-4632-11 159 001 769 Chlorine panel, transmitter, chlorine dioxide sensor (0.02 to 2 ppm), with sensor electronics,  pH sensor 
w/ electronics 

3-8630-3P 159 001 673 Panel mount chlorine and pH transmitter 

3-2630-1 159 001 746 Free Chlorine electrode, 0.02 to 2 ppm (mg/L)

3-2630-2 159 001 662 Free Chlorine electrode, 0.05 to 5 ppm (mg/L)

3-2630-3 159 001 747 Free Chlorine electrode, 0.01 to 20 ppm (mg/L)

3-2632-1 159 001 767 Chlorine Dioxide electrode, 0.02 to 2 ppm (mg/L) 

3-2724-00 159 001 545 Electrode, pH, fl at, PT1000,  ¾ in. NPT 

3-2750-7 159 001 671 pH - Inline Electronics, Digital (S3L), 4.6 m (15 ft) cable 

3-2650-7 159 001 670 Chlorine - Inline Amperometric Electronics, Digital (S3L), 4.6 m (15 ft) cable


